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Safety Information

Do NOT service or repair this product unless properly qualified. Servicing

should be performed only by a qualified technician or an authorized Audio

Precision distributor.

Do NOT defeat the safety ground connection. This product is designed to

operate only from a 50/60 Hz AC power source (250 V rms maximum) with

an approved three-conductor power cord and safety grounding. Loss of the

protective grounding connection can result in electrical shock hazard from the

accessible conductive surfaces of this product.

For continued fire hazard protection, fuses should be replaced ONLY with

the exact value and type indicated on the rear panel of the instrument and dis-

cussed on page 9 of this manual. The AC voltage selector also must be set to

the same voltage as the nominal power source voltage (100, 120, 230, or

240 V rms) with the appropriate fuses. Different fuses are required depending

on the line voltage.

The International Electrotechnical Commission (IEC 1010-1) requires that

measuring circuit terminals used for voltage or current measurement be

marked to indicate their Installation Category. The Installation Category is de-

fined by IEC 664 and is based on the amplitude of transient or impulse voltage

that can be expected from the AC power distribution network. This product is

classified as INSTALLATION CATEGORY II, abbreviated “CAT II” on the

instrument front panel.

Do NOT substitute parts or make any modifications without the written ap-

proval of Audio Precision. Doing so may create safety hazards.

This product is for indoor use—pollution degree 2.

Getting Started with Your 2700 Series Instrument v



Safety Symbols

The following symbols may be marked on the panels or covers of equip-

ment or modules, and are used in this manual:

WARNING!—This symbol alerts you to a potentially hazardous condition,

such as the presence of dangerous voltage that could pose a risk of electrical

shock. Refer to the accompanying Warning Label or Tag, and exercise extreme

caution.

ATTENTION!—This symbol alerts you to important operating consider-

ations or a potential operating condition that could damage equipment. If you

see this marked on equipment, refer to the Operator’s Manual or User’s Man-

ual for precautionary instructions.

FUNCTIONAL EARTH TERMINAL—A terminal marked with this sym-

bol is electrically connected to a reference point of a measuring circuit or out-

put and is intended to be earthed for any functional purpose other than safety.

PROTECTIVE EARTH TERMINAL—A terminal marked with this symbol

is bonded to conductive parts of the instrument and is intended to be connected

to an external protective earthing system.

Disclaimer

Audio Precision cautions against using their products in a manner not speci-

fied by the manufacturer. To do otherwise may void any warranties, damage

equipment, or pose a safety risk to personnel.

vi Getting Started with Your 2700 Series Instrument



Chapter 1

General Information

The 2700 Series: an Overview

Audio Precision 2700 series instruments are computer-controlled audio test

sets offering broad, high-performance capabilities for testing analog, digital,

and mixed-domain devices. The 2700 series instruments are based on models

in the Audio Precision System Two Cascade and Cascade Plus lines. A 2700

series instrument consists of two key components:

� The 2700 series instrument hardware, which provides the physical plat-

form and measurement electronics necessary for proper signal interface

and precise signal generation and analysis. The hardware is mounted in a

sturdy aluminum and steel chassis that can be installed in a standard

19" wide equipment rack using optional mounting hardware.

� The 2700 series control software, AP2700. AP2700 runs on a personal

computer (PC) and provides the control, computation, display, report and

automation functions for a 2700 series instrument. (The PC must be pur-

chased separately). The AP2700 control software will run under

Getting Started with Your 2700 Series Instrument 1
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Microsoft Windows 98, Windows 2000 and Windows XP operating sys-

tems.

With the exception of the mains power switch and the monitor speaker vol-

ume control, there are no knobs, dials, controls, readouts, meters or switches

on 2700 series instrument hardware. All of the measurement settings and ad-

justments are made in software on the PC.

The control software on the PC communicates with the 2700 hardware via a

proprietary bus interconnection called the Audio Precision Interface Bus

(APIB), which requires a dedicated APIB cable and PC-mounted APIB inter-

face card or adapter. APIB interfaces can be ordered as ISA, PCI or PCMCIA-

compatible devices.

2700 Series Capabilities

The fully-equipped 2700 series instrument, model SYS-2722, is a dual do-

main instrument; it can perform analysis in both the analog domain and the

digital domain simultaneously. The functional components implemented in

SYS-2722 include an analog signal generator, a digital signal generator, an an-

alog analyzer, a digital analyzer, and digital input and output and synchroniza-

tion capabilities. “Cross-domain” testing (for example, providing an input in

one domain to a converter such as an ADC or a DAC, and measuring the out-

put in the second domain) is straightforward, and can be performed using opti-

mal techniques and components for each domain.

The analog generator and analyzer have a number of hardware options that

can be added to enhance the instrument’s capability, including plug-in filters,

noise and tone burst generator options and dedicated intermodulation and wow

and flutter measurement modules.

Analog signals can be generated in analog circuitry, or can be generated

digitally and converted into analog signals. In the same way, analog signals

can be measured in the analog domain, or can be converted to the digital do-

main for digital analysis.

Digital signals are always generated and measured in the digital domain.

Digital analysis is performed by one of seven DSP analysis tools, including a

general-purpose audio analyzer, an FFT spectrum analyzer and a multitone an-

alyzer. A dedicated 80 MHz ADC is connected across the digital input, and is

available to digitize the serial interface bitstream for analysis.

These operations are all directed by AP2700, the 2700 series control soft-

ware. Nearly every function of AP2700 can be automated using the Audio Pre-

cision programming language AP Basic, which is provided with the control

software.

Chapter 1: General Information 2700 Series Capabilities
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About This Manual

You’re reading Getting Started with Your 2700 Series Instrument. This man-

ual describes how to set up the 2700 series instrument hardware, and the

AP2700 control software. It also contains a quick tutorial to familiarize you

with the system. The manual is organized as follows:

� Chapter 1: Introduction.

� Chapter 2: Software installation and hardware setup information.

� Chapter 3: Description of the hardware and its connectors.

� Chapter 4: Description of the user interface.

� Chapter 5: Introductory tutorial.

� Chapter 6: Specifications.

Other 2700 Series Documentation

Audio Precision publishes a variety of documents, many in electronic form,

about hardware and software products, audio theory, and test and measurement

techniques. The following list describes the documents that are included as

Adobe Acrobat PDF files on the CD-ROM that is included with your instru-

ment. They can also be downloaded from our Web site at audioprecision.com.

2700 Series User’s Manual

The 2700 Series User’s Manual is the primary operation and reference man-

ual for the system. Consult the 2700 Series User’s Manual for:

� Detailed descriptions of every 2700 series feature, software panel, con-

trol, and display.

� Reference information on audio test and measurement techniques, sam-

ple and utility file listings, and an audio glossary.

AP Basic Language Manual

You can create tests and macros to automate your measurements. Macros

are written in the AP Basic programming language, which is a subset of

Microsoft® Visual Basic®. The AP Basic Language Manual contains a list of

the AP Basic commands, each with a full description and example of usage.

About This Manual Chapter 1: General Information
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AP Basic Extensions Reference for the 2700 Series

The AP Basic Extensions Reference for 2700 Series Instruments contains a

list of ActiveX Automation (OLE) commands that control the specific features

of the 2700 series instrument hardware and the AP2700 control software.

Online Help

Much of the information contained in the 2700 Series User’s Manual is also

available in the online help system included in the 2700 series control soft-

ware. You can access the help system in two ways:

� Context-sensitive Help.

Almost every control and display on each software panel has a help topic

associated with it. To view the topic, click on the field or control, then

press the F1 function key.

� The Help menu.

On the Menu bar, click Help. The Help menu offers commands to search

the 2700 series Help files or select a specific help library such as AP Ba-

sic Language Help.

Filter Design Package Manual

The 2700 series can access and use downloadable filter files. This feature

allows you to install custom software high-pass, low-pass and weighting filters

for use with the 2700 series analyzer.

The 2700 series CD-ROM includes a version of Momentum Data Systems’

QEDLite filter design package. This special version creates filter files in the

format used by the 2700 series. The Filter Design Package manual describes

the operation of this software.

Other Publications

Audio Precision publishes application notes, technical papers, TECH

NOTES, and other material. These publications cover all aspects of audio test

and measurement. Information about out library of technical papers and an-

nouncements of new papers is available on the Audio Precision Web site at

audioprecision.com.

Chapter 1: General Information Other 2700 Series Documentation
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Chapter 2

Installation and Setup

2700 Series Components

The following items are included with a standard, APIB-configured 2700

series instrument.

� The 2700 series instrument chassis.

� A mains power cord.

� This manual, Getting Started with Your 2700 Series Instrument.

� The 2700 Series User’s Manual.

� The AP Basic Extensions Reference for 2700 Series Instruments.

� The AP Basic Language Manual.

� A packet of miscellaneous printed materials.

� A box containing the 2700 WIN-KIT interface kit.

The following items are contained within the 2700 WIN-KIT:

� An Audio Precision Interface Bus (APIB) interface card, as ordered
1
.

� An APIB interface cable.

� A CD-ROM containing AP2700, the control software for the 2700

series, and documentation files.

We recommend that you keep the shipping box and packing materials to

protect your instrument if you need to ship it in the future.

Getting Started with Your 2700 Series Instrument 5
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Getting Up and Running

There are three main tasks to setting up your 2700 series instrument:

� Installing the 2700 series control software (AP2700) on the PC;

� Configuring your 2700 series instrument for the local mains power sup-

ply; and

� Installing the APIB card in the PC and connecting it to the 2700 series

instrument.

These tasks are described below.

Installing AP2700 on a PC

PC System Requirements

Your 2700 series instrument must be connected to an IBM-compatible PC to

operate. The PC must have the following minimum features and capabilities:

� Windows 98, Windows 2000, or Windows XP as the operating system.

� At least the minimum processor type and memory required by Microsoft

for the installed operating system.

� At least 300 MB of free hard disk space.

� A CD-ROM drive.

� An open ISA, PCI or PCMCIA slot to mount the APIB interface card.

� A color monitor and a video card with at least VGA capabilities. Video

resolution of 1024�768 is recommended.

You will also need signal interface cables to connect your 2700 series in-

strument to your device under test (DUT). Since there are many possible con-

nection configurations, signal cables are not provided with the instrument.

Audio Precision offers cable kits with common connectors and adapters for

purchase. Contact a sales representative or visit the Audio Precision Web site

at audioprecision.com for more information.

Installing the Software

To install the 2700 series control software, use the following procedure:

� Close all Windows programs.

� Insert the AP2700 CD-ROM into the CD-ROM drive. The Windows

Autorun feature should start the installation program automatically. If it

does not, click on the Start menu and choose Run. Click Browse and

Chapter 2: Installation and Setup Getting Up and Running
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choose the file Setup.exe on the AP2700 CD-ROM. Click OK in the Run

dialog box.

� On the installation menu screen, click Install AP2700 Software. Follow

the on-screen instructions. The installation program prompts you to enter

the required information.

The installer may prompt you to reboot the machine. Although you do not

need to reboot immediately, you must reboot before you can operate your 2700

series instrument.

Setting Up the Hardware

Connecting your 2700 Series Instrument

to the Electrical Mains Supply

The 2700 series instrument must be connected to a 50–60 Hz alternating

current (ac) electrical mains supply, maximum voltage 250 Vrms.

The instrument has been configured at the factory for the expected voltage

at its intended destination, as ordered. The voltage setting and fusing arrange-

ment will normally be correct unless the instrument has been transported into

another area. The power entry module has a strip of indicator tape showing its

mains voltage setting. This tape must be removed before use.

You MUST be sure that the 2700 series instrument mains

power configuration is correct for the electrical mains power

supplied in your area. If you are not sure, do not plug the

instrument into the mains power. Follow the instructions

below to check or change the instrument mains supply

voltage selection.

The mains power supply is applied to your 2700 series instrument through

the power entry module located on the rear panel. Before connecting the

power cord, confirm that the input voltage selection and fusing arrangement in

the power entry module are correct for your mains power supply.

Setting Up the Hardware Chapter 2: Installation and Setup
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Checking the Mains Supply Voltage Configuration

The voltage indicator pin protrudes through one of the four labeled holes in

the module cover to indicate the selected input voltage, as shown in Figure 2.

Check that the indicated voltage matches your mains supply voltage.

Changing the Mains Supply Voltage Configuration

Unplug the power cord from the instrument before changing fuses or per-

forming any other operations described in this section.

To change the input voltage, refer to Figure 3 and proceed as follows:

� Remove the mains power supply cord from the power cord connector.

Figure 2. Detail, power entry module on 2700 series instrument rear panel.

Figure 3. Changing the mains power supply voltage.

Chapter 2: Installation and Setup Setting Up the Hardware
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� Open the power entry module cover with a small screwdriver or similar

tool. Set aside the cover / fuse block subassembly.

Pull the voltage selector card straight out of the housing, using narrow pliers

to grab the card. Do not use the indicator pin as a handle.

� Orient the selector card so that the desired input voltage is readable at the

bottom, shown in Figure 4. Then move the indicator pin to point UP,

with the pin assembly seated in the notch on the board edge.

� Insert the voltage selector card into the housing with the printed side of

the card facing toward the connector. The edge indicating the desired

voltage should enter the housing first.

� Confirm that the correct fuse or fuse combination is installed for the in-

tended input voltage (refer to the fuse ratings marked on the rear panel).

If necessary, change the fuse type as described in the following section.

� Replace the cover and verify that the indicator pin shows the desired

voltage.

Once you have verified that the line voltage selection is correct, connect the

power cord from a mains power outlet to the power cord connector on the in-

strument rear panel.

Fuse Information

The power entry module accommodates two fusing arrangements: North

American and European, as illustrated in Figure 5. The North American fusing

arrangement uses a single type 3AG (0.25" � 1.25") SB (slow blow) fuse; the

European fusing arrangement uses two 5�20 mm IEC-approved type T fuses.

Refer to the label on the rear panel for fuse current ratings.

Setting Up the Hardware Chapter 2: Installation and Setup
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Changing the Fusing Arrangement

To change the fusing arrangement, proceed as follows:

� Remove the mains power cord from the power cord connector.

� Open the cover of the power entry module with a small screwdriver or

similar tool.

� On the back of the cover, loosen the Phillips screw two turns, then re-

move the fuse block by sliding it up and away from the screw, and lifting

it from the pedestal at the other end, as shown in Figure 6.

� Invert the fuse holder and reassemble it on the Phillips screw and pedes-

tal, and tighten the screw.

� Change or add the correct fuses as necessary (again, refer to the rear

panel for the correct fuse current rating).

� Confirm the line voltage setting as described in the previous section, then

replace the cover.

Once you have verified that the line voltage selection is correct, connect the

power cord from a mains power outlet to the power cord connector on the

instrument rear panel.

Fuses

Fuse block

Cover
Jumper bar

230/240 V Orientation

FuseFuse block

Cover

Jumper bar

100/120 V Orientation

Figure 5. North American (left) and European (right) fusing arrangements.

Cover

Fuse Block

Fuse

Screw
Fuse Block
fits into notch

Support PedestalScrew Pedestal

Figure 6. Changing fuse types.
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Connecting the Instrument to Your PC

Before connecting the 2700 series instrument to your PC, install the

AP2700 control software. See page 6 for details.

The control software communicates with the 2700 series instrument through

the Audio Precision Interface Bus (APIB). We offer three options for the APIB

interface:

� The PCI card. Most newer PCs use the PCI bus exclusively; many PCs

have a mix of both ISA and PCI bus slots available.

� The ISA card. Older PCs use the ISA bus exclusively.

� The PCMCIA card. This card allows you to use an existing PCMCIA in-

terface found in many notebook computers.

Your system was shipped with an APIB interface cable and with the inter-

face option you ordered. Refer to the appropriate section for your interface be-

low.

Installing a PCI APIB Card

The Audio Precision PCI interface is compatible with

Windows 98, Windows 2000, and Windows XP. See the

Compatibility Chart in the Software area of the Audio

Precision Web site for current compatibility listings.

To install the PCI card, use the following procedure:

� Turn off your computer, remove the cover, and install the PCI APIB in-

terface card in an open PCI bus slot. Remember to handle the card prop-

erly to minimize static electricity discharges while installing it. Be sure

the card is well seated in the slot; it should snap down firmly into the bus

connector.
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� Secure the card bracket with the mounting screw and replace the com-

puter cover.

� Connect the APIB cable between the 2700 series instrument and the PCI

card.

� Turn on the computer. Windows should automatically find and identify

the APIB interface and install the correct driver.

Installing an ISA APIB Card

The Audio Precision ISA card is a half-size, 8-bit ISA card. To install the

ISA card, use the following procedure:

� Turn off your computer, remove the cover, and install the ISA APIB in-

terface card in an open ISA bus slot. Remember to handle the card prop-

erly to minimize static electricity discharges while installing it. Be sure

the card is well seated in the slot; it should snap down firmly into the bus

connector.

� Secure the card bracket with the mounting screw and replace the com-

puter cover.

� Connect the APIB cable between the 2700 series instrument and the ISA

card.

� Turn on the computer.

ISA Card Address Jumper Settings

The ISA bus requires a unique hardware address setting for each device

sharing the bus. The ISA APIB interface card uses jumpers to select one of

four possible addresses, as shown in Figure 8.
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Address 2d8 2b8 238 298

J202 Removed Installed Removed Installed

J201 Removed Removed Installed Installed

Notes Default

The card is shipped with the jumpers in the factory default position shown

in the table above. If there is a device conflict with the installation of the ISA

APIB card, that is, if another device is already using the address, move the

jumpers to change the card’s address.

Using a PCM-WIN PCMCIA Interface Card

The Audio Precision APIB PCMCIA interface is commonly

used with notebook computers.

To use the PCMCIA card, you must have a PCMCIA interface already in-

stalled in your computer.

ADDRESS 2d8 2b8 238 298

JUMPER INSTALLED

J202

J201

ADDRESS 2d8 2b8 238 298

JUMPER INSTALLED

JUMPER NOT INSTALLED

J202

J201

Factory Default
Setting 2b8

Figure 9. ISA card address jumper settings.

IN
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PCMCIA to
Audio Precision

Interface Bus

A
P

IB

For use with S1.EXE, LIB-C or APWIN

Figure 10. PCMCIA card and APIB cable.
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To install the PCMCIA card, use the following procedure:

� Insert the PCMCIA card into the PCMCIA interface.

� Connect the APIB cable between the 2700 series instrument and the

PCMCIA card.

Chapter 2: Installation and Setup Connecting the Instrument to Your PC
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Chapter 3

Hardware Overview

The 2700 series instrument hardware includes input and output connectors,

ranging and signal conditioning modules, digital signal processors, memory,

and other circuitry needed to perform audio measurements. It is connected to

the controller PC by the Audio Precision Interface Bus (APIB). This chapter

describes the connectors, controls and indicators on the instrument front and

rear panels. For a full list of hardware specifications, see Chapter 6.

All signal generation and measurement is performed in the 2700 series in-

strument hardware, including storage of signals acquired for DSP waveform

display or FFT analysis.

The SYS-2722 Front Panel

The SYS-2722 instrument front panel, shown in Figure 11, includes the dig-

ital and analog inputs and outputs, sync and monitor connectors, a headphone

jack and volume control, and the mains power switch and power indicator.
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Figure 11. SYS-2722 front panel.



� DIGITAL OUTPUT

In single-connector mode, the 2700 series instrument transmits stereo

digital audio simultaneously on the XLR “I” connector, the BNC connec-

tor, and the optical connector. In dual-connector mode, channels A and B

are transmitted on the XLR and BNC “I” and “II” connectors, respec-

tively.

� DIGITAL INPUT

In single-connector mode, the instrument receives stereo digital audio

from the XLR “I” connector, the BNC connector, or the optical connec-

tor. In dual-connector mode, channels A and B are received on the XLR

or BNC “I” and “II” connectors, respectively.

� ANALOG OUTPUTS

The instrument analog generator outputs (both “A” and “B” channels)

are available as balanced signals on the XLR and dual banana connec-

tors, and as unbalanced signals on the BNC connectors.

� ANALOG INPUTS

The XLR and dual banana (balanced) and the BNC (unbalanced) connec-

tors (both “A” and “B” channels) are connected to the instrument ana-

lyzer inputs.

� SIGNAL MONITOR PORTS

The instrument provides seven signal monitor outputs suitable for audi-

ble monitoring, oscilloscope viewing or other monitoring purposes.

Three of the signals originate within the Analog Analyzer. Four signals

originate in the Digital Analyzer and are converted to the analog domain

for monitoring.

� SYNC and TRIGGER PORTS

Two Analog Generator monitor outputs are available, along with an Ana-

log Generator Sync Output and an Analog Generator Trigger Input.

� GROUND CONNECTORS

Four banana-jack / bare-wire-terminal ground connectors are provided,

each connected to chassis ground.

� HEADPHONE JACK

A 1/4" stereo phone jack connected to the audible monitor output. In-

serting a plug into this jack interrupts the signal to the internal speaker.

� VOLUME CONTROL

The volume control adjusts the audio volume of both the internal speaker

and the headphone jack.

� POWER SWITCH and INDICATOR

The power switch turns the mains power supply to the instrument hard-

ware ON ( I ) or OFF ( O ).

Chapter 3: Hardware Overview The SYS-2722 Front Panel
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See Chapter 4 of the 2700 Series User’s Manual for more information about

the instrument inputs and outputs and the panels associated with them.

The 2700 Series Rear Panel

The SYS-2722 instrument rear panel, shown in Figure 12, includes the

power entry module, sync and reference inputs and outputs, parallel digital in-

put and output, APIB interface connectors and the instrument configuration

and serial number labels.

� POWER ENTRY MODULE—this module includes:

� POWER CORD CONNECTOR—This is a standard grounded

connector for the mains power supply cord.

� FUSE HOLDER/MAINS SUPPLY VOLTAGE JUMPER—Contains

the mains power fuse and the mains supply voltage configuration

jumper card. See Chapter 2.

� MAINS SUPPLY VOLTAGE INDICATOR—The white tip of the

plastic indicator on the voltage configuration jumper card appears in

one of four small holes to show the mains voltage selection. See

Chapter 2.

� SYNC and REFERENCE OUTPUTS

� AES/EBU Reference

� Master Clock Out

� Transmitter Frame Sync Out

� Receiver Frame Sync Out

The 2700 Series Rear Panel Chapter 3: Hardware Overview

Getting Started with Your 2700 Series Instrument 17

Configuration Label APIB Ports

Mains Power Entry
Fusing and Voltage

Configuration

Sync and Reference
Inputs and Outputs

Parallel Digital Input and Output

Figure 12. SYS-2722 rear panel.



� Aux Out

� Trigger Out

� SYNC and REFERENCE INPUTS

� AES/EBU Reference

� Video/TTL Reference

� External Trigger In

� PARALLEL PORTS

Digital Audio Input and Output in parallel format, compatible with Au-

dio Precision PSIA-2722 Programmable Serial Interface Adapter input

and output.

� APIB INTERFACE—These connectors provide the two-way Audio Pre-

cision Interface Bus connection between the instrument and the PC

running the control software.

See Chapters 4 and 24 of the 2700 Series User’s Manual for more informa-

tion about the instrument rear panel parallel digital and sync and reference in-

puts and outputs.
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Chapter 4

2700 Series Control Software

Overview

Most of your interaction with your 2700 series instrument will be through

the control software, AP2700. Once the system is plugged in, turned on and

connected to your device under test (or DUT), you will be making all your ad-

justments and taking all your readings from your computer screen.

The 2700 series control software is a powerful and complex program, and

most of the 2700 Series User’s Manual is dedicated to exploring and explain-

ing its many capabilities. This chapter provides an introduction to the software

features. Chapter 5 provides a brief tutorial on the basics of operating the sys-

tem.

The User Interface

Like many Windows applications, the 2700 series control software has a

menu bar, a status bar, toolbars, and a workspace. With these tools you can

save test and data files, export and print measurement results, configure both

the hardware and software to your needs, access online help, design and

launch automated processes and open and operate the measurement control

panels.

The Workspace

The 2700 series workspace has five pages that you can select by menu com-

mands (View > Page #) or by clicking the numbered tabs on the Status Bar.

The workspace is like a multi-layered desktop where you can display and or-

ganize the control panels you are using for a particular set of tests.
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Panels can be placed on any workspace page, and can be duplicated on

more than one page. An control panel that appears on more than one page is

simply a redundant display, for your convenience. The settings and results

shown on redundant panels are identical, and a change made on one page is re-

flected on the others.

The 2700 series panels

The interaction between the control software and the 2700 series instrument

is through control and measurement windows called panels. These can be

thought of like the physical control panels often found on conventional test

and measurement equipment, with range, function and trigger controls, ON

and OFF switches, linear adjustment pots and sliders, numerical meter read-

outs, bar meters, X-Y waveform displays, graphs and so on.

The 2700 series panels are available through menu commands, toolbar icons

and keyboard shortcuts.

You can control your 2700 series instrument from just one or two software

panels, if that’s all your measurement requires. A more typical test might in-

volve four or five panels; a complicated test, perhaps six or seven.
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Although the 2700 series panels can all be placed on one workspace page,

most users prefer to organize their workspace by placing panels on several dif-

ferent pages.

You can close a panel without canceling its function or effect; for example,

you could set a signal’s output voltage and frequency on the Analog Generator

panel, turn the generator ON, then close the panel window. The signal will

continue at the settings you’ve made until you open the panel again and make

changes to the settings.

Many of the 2700 series panels come in two sizes, the smaller having fewer

commands and readouts visible, and the larger showing every option. Double-

click on the panel title bar to expand or contract it.

Panel Settings

Settings for tests and measurements are made using several different types

of controls on the panels:

� Setting fields, which come in several versions:

� The text box, in which you can directly enter a value from the

keyboard.

� The drop-down list box, in which you can make a selection from a set
of choices.
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� The combo box, a combination of a text box with an added drop-
down list from which you can choose the units to express your value.

Setting fields display dark (black or blue) text or numbers on

a white field. 2700 series text boxes and combo boxes,

where appropriate, will accept certain letters as shorthand for

standard SI multipliers: “n” for nano- (10
–9

), “u” for µ or micro-

(10
–6

), “m” for milli- (10
–3

), “k” for kilo- (10
3
) and “M” for

mega- (10
6
). For example, entering either “1001” and

“1.001k” in a frequency field will set the frequency to

1.001 kHz.

� Check boxes, which allow you to set non-exclusive conditions.

� Option buttons, which provide for exclusive conditions.

� Browser buttons, which open dialog boxes called browsers, which allow
you to navigate lists of options, search for a file by browsing through a
hierarchy of folders, and so on. Browser buttons are identified by the
ellipses mark ( … ).

� Custom buttons that control special functions, such as GO, ON, OFF
and so on.

� Sliders, with which you can continuously adjust a value. Sliders are
found on Bar Graph panels. Sliders can be operated by either the mouse
pointer or by using the arrow keys.

Panel Readings

Results of tests or measurements are called readings, which the 2700 series
control software can display in several ways:

� Reading fields, sometimes called measurement fields or meters. Reading

fields come in two variations, with and without a drop-down list to select

units.

Reading fields always display green text or numbers on a

black field.

� Bar graphs, which display values as a continuous colored bar, like a con-
ventional analog meter.

� Status indicators, which show the presence or absence of a condition by
a small colored rectangle.
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The 2700 series menus

The 2700 series Menu bar extends across the top of the window and is al-

ways visible. In this section we will take a brief tour of the 2700 series menus.

Details of menu options, controls and submenus will be explored in the user’s

manual.

The File Menu

The File menu offers commands for opening, saving, appending, importing,

exporting and printing 2700 series files, and access to the Quick Launch menu.

Since there are a number of different files types used by the 2700 series,

submenus are available (at the small black arrows � accompanying some menu

choices) to choose, for example, whether to Save As a Test, Data or Macro

file.

The listings at the bottom of the File menu show the last tests opened by the

2700 series, and provide a convenient way to quickly launch a previously used

test. Simply click on the name of the test you would like to open.
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The Edit Menu

The Edit Menu provides several groups of commands:

� Undo and Cut, Copy, and Paste provide editing functions for 2700 se-

ries text entries.

� Copy Panel to Clipboard places a bitmap image of the selected 2700

series panel on the Windows clipboard.

� The Set Analyzer and Set Generator commands provide an easy way to

set reference levels and frequencies for the Analog Analyzer and Analog

Generator panels for relative measurements. These are discussed in detail

in the user’s manual.

� Reset Bar-graph Max/Min clears the gray minimum/maximum excur-

sion bar from a selected Bar Graph display.

� The four last commands are only active when the Data Editor is open

and selected, and provide the means to insert, add and delete data rows.

See the user’s manual for more information about using the Data Editor.
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The View Menu

The View menu enables you to choose which workspace page to view, and

whether or not the Status bar and any combination of Toolbars are displayed.

A checkmark next to a View menu listing indicates that the selection is visible.

You can also open the Attached Files viewer from the View menu. Go the

user’s manual for more information about the Attached Files viewer.
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The Panels Menu

The Panels menu shows all the control panels available in the control soft-

ware. Click on a Panel name (or on its corresponding Toolbar button) to open a

panel on the current workspace page. Panels can be duplicated on more than

one page for convenience.

Closing a panel does not stop its activity. If a generator panel

has been set to output a sine wave, or an analyzer panel to

measure a voltage, these activities continue whether or not

the panel is visible on any page.

The panel functions are discussed in detail in the 2700 Series User’s Man-

ual.

26 Getting Started with Your 2700 Series Instrument

Chapter 4: 2700 Series Control Software The 2700 series menus



The Status Bar

The Status bar runs across the bottom of the workspace. On the right, the

Status bar displays the workspace page tabs; on the right are status notes up-

dated as the control software operates.

The Toolbars

The 2700 series control software has five toolbars for quick access to panels

and common functions. The toolbars can “float” at any location you place

them on the workspace, or they can be “docked” or attached to the Menu bar.

Whether docked or floating, the toolbars appear on every workspace page.

The toolbars display command buttons for one-click access to many often-

used functions. See the 2700 Series User’s Manual for detailed information.

The Standard Toolbar

The Standard toolbar gives you quick access to 2700 series file, printer and

editing operations, as well as Sweep Stop/Start and FFT Time/Frequency do-

main switching. See the 2700 Series User’s Manual for detailed information.

The Panels Toolbar

The Panels toolbar gives you quick access to 2700 series measurement and

control panels: See the 2700 Series User’s Manual for detailed information.

The Macro Toolbar

The Macro toolbar offers one-click operations for running and editing an

AP Basic macro. See the 2700 Series User’s Manual for detailed information.
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The Learn Mode Toolbar

Learn mode logs all your 2700 series operations as you perform them,

building a macro (script) for automation purposes. The Learn Mode toolbar

gives you the ability to turn the macro recording function ON and OFF with a

click of the mouse. See the 2700 Series User’s Manual for detailed informa-

tion.

The Quick Launch Toolbar

Quick Launch allows you to create and use custom toolbar buttons to open

2700 series tests, run AP Basic macros and even launch other Windows pro-

grams.

From the Main menu, choose File > Quick Launch > Customize Quick

Launch to open the Quick Launch Configuration panel, where you can view

or edit the existing Quick Launch commands or to add new commands of your

own.
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For each toolbar command, enter (or browse to) a command line with a

complete path in the Command field. Name the command in the Menu Text

field, and choose a toolbar button icon using the icon browser to the right. If

you would like a macro from the Quick Launch toolbar to run immediately,

check Automatically run when loaded.

To open the test, macro or program, click the button on the Quick Launch

toolbar. In a default installation, the Quick Launch sample files are installed

under …\Program Files\Audio Precision\AP2700\Quick Launch\.

See the 2700 Series User’s Manual for detailed information.
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Chapter 5

Quick Guides

Introduction

The Quick Guides in this chapter provide a way to get familiar with the

2700 series user interface, and to get some immediate results from your instru-

ment. As you become more comfortable with the system, please refer to the

2700 series User’s Manual for further information.

The Quick Guides begin with the assumption that your 2700 series instru-

ment is turned on and connected to your PC, and that the AP2700 software has

been launched and is in communication with and properly controlling your in-

strument. No audio cables or external devices under test (DUTs) are needed for

the Quick Guides.
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The Analog Signal Path

When the 2700 series control software is launched, the default Page 1

workspace is loaded with two panels, the Analog Generator and the Analog

Analyzer, as shown in Figure 16. To return to this configuration at any time,

click the New Test button. Previous settings and data will be discarded.

Analog Input Selection

The 2700 series has two channels of analog input that are accessed from the

Analog Analyzer panel. Each channel can receive a signal from its front panel

balanced or unbalanced connector, or via an internal path from the Analog

Generator. The Source fields on the Analog Analyzer panel present these

choices in a drop-down list. Go to the Analog Analyzer by selecting Panels >

Analog Analyzer or by clicking the Analog Analyzer button. Choose

GenMon for each channel to select the internal path.

Analog Generator Panel
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Figure 18. Analog Generator, OUTPUTS

ON, CHB OFF.



In the default configuration, the Analog Generator panel is set for a 1 Vrms,

1 kHz sine wave, but the analog outputs are disabled. To turn on the outputs,

click the OUTPUTS OFF button near the center of the panel. The button will

turn green, and you will hear relays click in the instrument hardware. The

Level meters on the Analog Analyzer panel will show approximately 1.000 V.

The Level meters show the rms level of the signals at the analog inputs.

The stereo Analog Generator outputs can be individually disabled with the

CHA and CHB buttons next to the OUTPUTS field. Click on the CHB button.

The button will turn gray, relays will click in the instrument, and the Chan-

nel B Level meter on the Analog Analyzer panel will indicate a level of

0.000 V.

Now that we’ve successfully routed a signal from the Analog Generator to

the Analog Analyzer, we will perform some basic measurements.

Using the Analog Analyzer

The 2700 series has two independent general-purpose analyzers that can

perform measurements on analog signals. We will be using the Analog Ana-

lyzer for the Quick Guide; the alternative DSP Audio Analyzer is an analysis

tool available on the Digital Analyzer panel that offers similar analysis capa-

bilities. You can read about the both analyzers in Chapters 8 and 10 of the

2700 Series User’s Manual.

The Analog Analyzer is an analog-domain real-time audio analyzer, imple-

mented in instrument hardware. It provides continuous readings of signal level

and frequency for both input channels. It also allows you to select a channel

and apply filtering to it, and to measure parameters such as total harmonic dis-

tortion, phase, and so on.

At this point, you should have the setup shown in Figure 19:

� Analog Generator Channel A producing a 1 V, 1 kHz sine wave.

The Analog Signal Path Chapter 5: Quick Guides

Getting Started with Your 2700 Series Instrument 33

Figure 19. Analog Generator routed to Analog Analyzer inputs; generator Channel B is

set OFF in this illustration.



� Analog Generator Channel B OFF.

� Analog Analyzer Channel A and B input Sources set to the internal gen-

erator path, GenMon.

The topmost meters in the Analog Analyzer panel (just below the Source

selection fields) show the audio level in volts. You should see approximately

1 V in the left-hand meter (Channel A), and approximately 0 V in the right-

hand meter (Channel B). Click the CHB button on the Analog Generator panel

to re-enable the Channel B generator signal. You now see approximately 1 V

in the right-hand level meter on the Analog Analyzer panel, since the Channel

B generator is now active and its signal is being routed to the analyzer via the

GenMon internal path.

The meters in the next row of the Analog Analyzer panel show the fre-

quency of the signal in each channel. Both of these meters should be reading

very close to 1 kHz, the frequency of the analog generator.

Audible Signal Monitor

2700 series instruments have an internal mono speaker to monitor both ana-

log and digital input signals. In addition, the signal at the speaker is available

at the headphone jack on the instrument front panel. The volume control for

signals applied to both the speaker and the headphone jack is located on the

front panel next to the jack. When a headphone plug is inserted into the jack,

the internal speaker is disconnected.

The signal applied to the speaker and headphone jack is selected on the

Headphone/Speaker panel. Click the Headphone/Speaker button on the Panel

toolbar, or go to Panels > Headphone/Speaker on the Main menu. On the

Headphone/Speaker panel, drop the Source list and select Analog Input, and

turn up the front panel volume control. You will hear the 1 kHz tone from the

generator become louder. In the default New Test setup, the Headphone/

Speaker mode is stereo, and the mono speaker in the instrument sums both

channels of the signal. Click the CHA button on the Analog Generator to dis-

able the channel A signal. The speaker level will drop by about half, since it is

now reproducing only the channel B signal. Click CHA ON again, and the

sound will get louder.
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Controlling the Analog Generator

The topmost two fields in the Analog Generator panel control the generator

waveform. The Analog Generator is capable of producing sine waves, square

waves, noise and other waveforms. At this point the waveform should be set to

Sine: Normal (Sine in the left field, that is, and Normal in the right). Drop

down the left-hand list box and choose Square to change the waveform to a

square wave. If you are monitoring the signal with the internal speaker, you

will hear the timbre of the signal change. You will also see the signal level

change in the Analog Analyzer panel. (A square wave has a higher rms level

than a sine wave for a given amplitude setting.)

The square waveform has one parameter or setting available: the frequency.

This is set in the field below the waveform selection fields. We will now

change the generator frequency to 2 kHz, as follows:

� Click in the Frequency field in the Analog Generator panel. The text

1.00000 kHz becomes highlighted.

� Use the keyboard to type 2k, the new generator frequency. As you can

hear in the monitor speaker, the frequency does not change.

� Now press the Enter key. The text changes to 2.00000 kHz, the pitch in-

creases from the monitor speaker, and the frequency reading in the Ana-

log Analyzer panel changes to about 2 kHz.

Now switch the waveform type back to sine. The current square wave fre-

quency is used for the sine wave.

You can enter standard SI prefixes for multipliers as you

enter the value in the setting field. For example, ‘2000’, ‘2k’,

‘0.002M’, and ‘2000000m’ all produce the same frequency.

All waveforms can be generated at any amplitude from 0 V to the maximum

output voltage of the instrument. The amplitude for each channel is controlled

by fields below the OUTPUTS field. If the Track A checkbox is checked, the
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amplitude is identical in both channels and is set by the Channel A Amplitude

field at the left of the panel. If Track A is unchecked, a Channel B Amplitude

field appears at the right of the panel, and the amplitudes of the two channels

can be varied independently.

Change the Channel A Amplitude to 0.5 V by clicking in the Amplitude

field on the Analog Generator panel, typing 0.5, and pressing Enter. The level

meter reading on the Analog Analyzer panel will change. (You will also hear

relays click if the system needs to change the analog range.) Now uncheck

Track A and set the channel B amplitude to 10 V. The level meters on the Ana-

lyzer panel will show the different levels. Both frequency meters, however,

will show the same frequency. This is because the Sine: Normal waveform

generates identical frequencies in the two channels.

The Sine (D/A): Stereo waveform, which is obtained by choosing Sine (D/

A) from the left-hand waveform field and Stereo from the right-hand wave-

form field, can generate independent frequencies in the two channels. You can

verify the frequency in set each channel by referring to the frequency meters

on the Analog Analyzer panel.

Units

Settings and readings consist of a value and a unit. The 2700 series can con-

vert the units of a setting or reading to a related unit. For instance, the analog

generator amplitude can be set in Vp (volts peak), dBV (decibels relative to

1 V), and several other units. Similarly, readings can be displayed on a meter

in any of the related units.

The list of units for a setting or reading can be viewed by clicking the

downward-pointing arrow next to the setting or reading field. For instance, the

list of units for the analog generator amplitude can be displayed by clicking on

the arrow next to the Amplitude field on the Analog Generator panel. The con-

trol software displays the value currently in the field, converted to each avail-

able unit. By clicking on the list, you can choose a setting unit.

As an example, if the amplitude is set to 1 Vrms, the drop-down list in-

cludes conversions such as 1.414 Vp and 2.220 dBu. If you click on the line

displaying the amplitude in Vp, the setting changes to 1.414 Vp. The generator

amplitude has not changed; the setting is displayed in a different unit. You can

now set the generator amplitude in Vp.

Some units, such as dBr, depend on a reference set in a reference field, such

as those at the bottom of the large views of the Analog Generator or Analog

Analyzer panels. Refer to Appendix A of the 2700 Series User’s Manual for

more information about units of measurement.
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Sweeps

Most device testing with the 2700 series is performed using sweeps. In a

sweep, a setting is stepped over a pre-defined range, while selected readings

are gathered. The result is a table of data relating the readings to each value of

the setting.

For instance, if you wanted to measure the frequency response of an analog

amplifier, you might vary the frequency of the Analog Generator from 20 Hz

to 20 kHz in 30 logarithmic steps, while monitoring the Analog Analyzer

Channel A and Channel B level readings. The result would be a table of data

with 30 rows (one for each frequency step) and 3 columns (one for the fre-

quency setting, one for the Channel A level reading, and one for the Channel B

level reading).

You can force the 2700 series to perform a “single-point

sweep” for special purposes, but generally the term sweep

indicates that a number of data points are included in the

measurement.

When a sweep is performed, a graph is also created. This is a graphical rep-

resentation of the data obtained during the sweep. Figure 22 shows an example

of a stereo frequency response graph.

The Sweep panel contains many more features than are described here. See

Chapter 17 of the 2700 Series User’s Manual for more information.
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Sweep Fundamentals

Settings and Readings

To set up a sweep, open the Sweep panel, either by choosing

Panels > Sweep, or by clicking on the Sweep button. The Sweep panel is di-

vided horizontally into two major areas: the Data (reading) area above, and

the Source (setting) area below. During the sweep, the setting chosen in the

Source 1 field is varied, and the readings specified in the Data fields are gath-

ered.

To choose the setting to be varied, click on the ellipsis button to the right of

the Source 1 field. In the browser, choose an instrument from the left pane and

a setting from the right pane. For instance, if you choose Gen from the instru-

ment side and Freq from the setting side, the frequency of the Analog Genera-

tor will be varied during the sweep. This is shown in the Source 1 field as

Gen.Freq.
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of Figure 22.



To choose a set of readings to be gathered, click on the ellipses button to the

right of the Data 1 field. The browser shows instruments in the left pane and

readings in the right pane. If you choose the Anlr instrument and the Level A

reading, the level on channel A will be recorded during the sweep. This is

shown in the Data 1 field as Anlr.Level A.

The Stereo Sweep checkbox near the bottom of the Sweep panel automati-

cally ensures that readings from both channels are gathered during the sweep.

For instance, if you choose Anlr.Level A as the reading in Data 1 and then

check the Stereo Sweep checkbox, the reading Anlr.Level B will also be gath-

ered (in Data 3) during the sweep.

Source Range, Steps, and Spacing

During the sweep, the setting in Source 1 is stepped from the Start value to

the Stop value shown in fields below Source 1. The number of steps in the

sweep is shown in the Steps field. A button to the right of these fields controls

whether successive settings are separated linearly or logarithmically. In a lin-

ear sweep, the difference between successive settings is constant. In a logarith-

mic sweep, the ratio between successive settings is constant.

For example, if the Start frequency is 20 Hz, the Stop frequency is 20 kHz,

there are 3 steps, and the Spacing is logarithmic, the control software will first

set the generator to 20 Hz, then 200 Hz, then 2 kHz, and finally 20 kHz; that

is, the ratio between successive frequency settings is 10.

On the other hand, if the Spacing is linear, the generator is first set to 20 Hz,

then 6680 Hz, then 13340 Hz, and finally 20 kHz; that is, the difference be-

tween successive frequency settings is 6660 Hz.
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Figure 24. A Sweep browser. Appearance is similar

for Source and Data browsers, for settings or for

readings.



Data Display Range

A graph is automatically created when a sweep is run. The Start and Stop

values for Source 1 define the extent of the horizontal (x-) axis. The extent of

the vertical (y-) axis is determined by the values in the Top and Bottom fields

beneath Data 1.

The units of the y-axis are the same as the units in the Top and Bottom

fields. If you change the units of the Top or Bottom field, the units in the other

field will also change. See Units on page 36 for more information on units.

We will now perform two example sweeps: a frequency response sweep,

and an amplitude linearity sweep.

Example Sweep: Frequency Response

For this example, we will measure the frequency response flatness of the

2700 series itself. We connect the analog output to the analog input, sweep the

frequency of the analog generator over the audio range, and plot the level mea-

sured by the analyzer against frequency.

First, click the New Test button, turn the analog generator on, and set both

Analog Analyzer input channels to GenMon so that the generator signal is

sent directly to the analog input. Now click the Sweep button to open the

Sweep panel. The default sweep is a mono frequency response sweep, so we

only have to make a few modifications:

� Check the Stereo Sweep box to create a stereo sweep.

� Change the Steps from 30 to 100 for a more detailed response.

� The default range for Data 1 is quite wide, and the units are Volts.

Change the units to dBV by clicking on the arrow next to the Top field.

From the list, choose the dBV line. (Note that the units in the Bottom
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To set up a sweep, you must

set to the setting to be varied during the sweep

set to the reading to be collected during the sweep

click Stereo Sweep if you wish to collect data from both channels

set the Start, Stop, Steps, and Lin Log for and

set the Top and Bottom values and units for .

Once the sweep is set up, you can run it by clicking the button at
the bottom of the Sweep panel.



field change also.) In the Top field, type 0.1. In the Bottom field,

type –0.1.

You can now click the Go button to run the sweep. A graph is created, and

the response is plotted as the sweep progresses. If you are monitoring using the

internal speaker, you will hear the analog generator frequency step through the

audio range. The result will be a response curve that deviates only slightly

from 0 dBV, as shown in Figure 25.

Example Sweep: Amplitude Linearity

For this example, we will measure the amplitude linearity of the 2700 series

instrument. With the Analog Generator output connected to the Analog Ana-

lyzer input, we sweep the amplitude of the Analog Generator over its full

range, and plot the ratio of the level measured by the Analog Analyzer Level

meters to the generator output level, in dB. Any amplitude non-linearity in the

system will show as a deviation from 0 dB.

First, click New Test, turn the Analog Generator ON, and set the Analog

Analyzer Source A and B to GenMon so that the generator signal is sent di-
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Figure 25. Current workspace after frequency response sweep,

showing typical results.



rectly to the analog input. Now click the Sweep button to open the Sweep

panel and make the following changes:

� Click the Source 1 browser button, and choose Gen as the instrument

and Ampl A as the setting.

� Select the dBg A units for Data 1 by clicking on the arrow next to the

Top field, and choosing the dBg A line from the list. The dBg A units

(decibels relative to generator channel A) show the ratio of the reading to

the level of the Analog Generator, in dB.

� Set the Data 1 Top value to 0.1, and the Bottom value to –0.1.

Click Go to start the sweep. The ranging relays will click as the generator

changes amplitude. The result will be a curve that deviates only slightly from

0 dBg A, as shown in Figure 26.
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Figure 26. Current workspace after amplitude linearity sweep, showing

typical results.



DSP Analysis

In addition to the hardware-implemented Analog Analyzer, the 2700 series

provides a number of software-implemented analysis tools in the Digital Ana-

lyzer panel. These tools analyze digital domain signals using digital signal

processing (DSP). The DSP Audio Analyzer, which offers similar capabilities

to the Analog Analyzer, is one example. Another is the FFT Spectrum Ana-

lyzer, which we will look at next.

Analog signals must be converted from the analog domain to the digital do-

main for DSP analysis. When performing digital analysis of analog signals, the

2700 series uses the input circuits of the Analog Analyzer for interface and

ranging, and then routes the analog signals to an analog-to-digital converter

(ADC) before applying them to the Digital Analyzer for DSP analysis.

The FFT Spectrum Analyzer

Open the Digital Analyzer panel by choosing Panels > Digital Analyzer or

by clicking the Digital Analyzer button.

At the top of the Digital Analyzer panel is a drop-down list of the DSP anal-

ysis tools available in the 2700 series.

Up to this point, we have been using the hardware-implemented Analog

Analyzer to make measurements. We will now take a look at the FFT Spec-

trum Analyzer. This analysis tool displays audio signals in time (oscilloscope-

style) and in frequency (spectrum analyzer-style). It operates in a different

fashion from the Analog Analyzer, as explained next.
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Figure 27. Digital Analyzer analysis tool selection.



Real-Time vs. Batch-Mode Instruments

The Analog Analyzer is a real-time instrument. That is, it returns readings

continuously, whether or not a sweep is in progress. These readings include

level and frequency, as well as functions such as distortion or phase. During a

sweep, readings from the audio analyzer are diverted from the panel meters to

the sweep engine for graphing. After the sweep, the readings are once again

displayed in the panel meters.

By contrast, the FFT Spectrum Analyzer is a batch-mode instrument. It does

not generate readings if a sweep is not being performed. When a sweep is

started, the Spectrum Analyzer first acquires a segment of audio by storing it

in memory. This is indicated (briefly) on the Status bar as DSP Acquiring

Data. Once the acquisition is complete, the Spectrum Analyzer processes the

data. This is indicated as DSP Transforming Data (again, briefly) on the Sta-

tus bar. Once processing is complete, the control software fetches a batch of

readings from the Spectrum Analyzer. At that point, the data is graphed.

The FFT Concept

The FFT (fast Fourier transform) is an efficient way to decompose a peri-

odic signal into its component frequencies. It transforms a time-domain signal

(such as you might see in an oscilloscope trace) into a frequency-domain repre-

sentation.

As an example, a high-quality power amplifier fed with a sinusoidal input

will produce harmonic distortion at its output that is invisible in an oscillo-

scope trace. If an FFT is performed on the output signal, however, the individ-

ual distortion harmonics can be seen. The pattern of harmonics provides

insight into the mechanisms responsible for the distortion.

The FFT process consists of the following steps:

� Triggering. The system waits for a trigger event from the selected

source, for instance, a positive-going zero crossing of the analog genera-

tor.

� Acquisition. The system stores the input audio in memory until the se-

lected number of audio samples has been received. The more audio data

acquired, the more frequency points there will be in the result, and hence

the higher the resolution will be. However, longer acquisitions take more

time.

� Windowing. Before transformation, the audio data is shaped in time by

multiplying it with a pre-defined envelope. This increases the accuracy

of the amplitude values returned from the FFT.
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� Transformation. The windowed audio data is transformed by the FFT.

This results in an array of points describing the magnitude and phase of

each frequency in the audio signal.

� Display. The control software fetches the transformed audio data and

graphs it. Because the number of transformed points is typically larger

than the number of points in the graph, a peak-picking method is used to

ensure that peaks in the frequency data are not missed.

For more information, see Appendix C of the 2700 Series User’s Manual.

Setting up an FFT

Click New Test and open the Digital Analyzer panel. After a New Test, the

Digital Analyzer panel defaults to None as its analyzer. To switch to the Spec-

trum Analyzer, click the down arrow next to the Analyzer field at the top of

the Digital Analyzer panel. From the list, choose FFT spectrum analyzer

(fft). The panel changes to display the analysis tool.

Panel Fields

There are two peak monitors near the top of the panel, one for each of the

stereo channels. These meters give an indication of the presence of signal at

the FFT input.

Below the peak meters is an array of fields for configuring the analyzer.

Here, we will use the default settings. For more details on the settings, see

Chapter 11 of the 2700 Series User’s Manual.

Time vs. Frequency

As mentioned, the FFT spectrum analyzer can display audio signals in the

time domain and the frequency domain. The choice of domain is determined

by the Source 1 field on the Sweep panel. If it is set to Fft.FFT Time, a time
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Figure 28. FFT Spectrum Analyzer panel.



domain display results. If it is set to Fft.FFT Frequency, a frequency domain

display results.

The Sweep Spectrum/Waveform button in the Standard toolbar allows

FFT sweeps to be set up quickly, entering Fft.FFT Time or Fft.FFT Fre-

quency in the Source field and setting default ranges. We will use this feature

to examine harmonic distortion in the 2700 series.

Quick Sweep Setup

Click New Test, turn the Analog Generator ON, and set the Analog Ana-

lyzer Source A and B to GenMon so that the generator signal is sent directly

to the analog input.

Now open the Digital Analyzer panel and switch to the Spectrum Analyzer

by selecting FFT spectrum analyzer (fft) from the drop-down list.

Open the Sweep panel and click the Sweep Spectrum/Waveform button on

the Standard toolbar. The sweep is automatically set up for a stereo frequency

domain display from 20 Hz to 20 kHz.

Click Go to perform the sweep. A graph similar to Figure 29 is created.

The large peak in the middle of the spectrum is the 1 kHz, 1 V sine wave

fundamental produced by the analog generator. There are smaller peaks spaced

at 1 kHz intervals above the fundamental. These are harmonic distortion com-

ponents generated in the 2700 series hardware. These harmonics rise out of a

wideband system noise floor.

To look at the audio signal in the time domain, click the Sweep Spectrum/

Waveform button again. Source 1 changes to Fft.FFT Time and the graph

updates to show the new data. You should see a graph similar to Figure 30.
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Figure 29. Typical default FFT stereo frequency domain graph.



The display shows a sine wave with a period of 1 ms (corresponding to a

frequency of 1 kHz) and a peak excursion of 1.414 V (corresponding to an am-

plitude of 1 Vrms). The effect of the distortion on the waveform is not visible

in the time domain.

You can switch between the time domain and frequency domain displays at

any time by clicking the Sweep Spectrum/Waveform button.

Fine-Tuning the Display

There are several ways to adjust the graph display to more closely examine

features of the acquired waveform:

� Zoom

On the graph, draw a box by holding down the left mouse button and

moving the mouse. When you release the button, the software zooms the

selected area to the full graph size.

� Zoomout

After zooming, click the right mouse button on the graph. From this

right-click menu, choose Zoomout. The graph zooms out to the pre-

zoom size.

� Optimize

From the right-click menu, choose Optimize Left Only. The vertical

axis changes to best fit the data in the graph.

For more details, see Chapter 18 of the 2700 Series User’s Manual.
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Saving and Loading Tests

At any time, the current workspace setup can be saved to a file. The file

contains the settings on all the panels (including panels that are not visible in

the workspace), the panel positions, and references to any other files that were

attached, such as limit data. The file also contains the most recent data ob-

tained from any sweeps that were run.

When a test is loaded, the workspace reverts to the exact configuration it

had when the test was saved. The data from the test is available and can be fur-

ther processed. It can also be re-graphed automatically when the test is loaded.

See Chapter 27 of the 2700 Series User’s Manual for configuration details.

To save the current workspace, choose File > Save > Test, or click the Save

Test button in the Standard toolbar. To load a lest, choose File > Open > Test,

or click the Open Test button in the Standard toolbar.

The Next Step

In this chapter, we have introduced two analysis tools: the Analog Analyzer,

and the FFT Spectrum Analyzer. The 2700 series has other tools to measure

audio signals in different ways. The 2700 Series User’s Manual describes all

the analysis instruments in detail.

We have also introduced the sweep, which is at the heart of 2700 series au-

tomated measurements. The sweep engine and its features are described in

more detail in Chapter 17 of the 2700 Series User’s Manual.

We set up tests by hand using the mouse and keyboard, and saved them to

disk. The control software also contains a complete programming language

called AP Basic that allows you to execute complex measurement sequences

programmatically. Chapter 25 of the 2700 Series User’s Manual introduces

programming and automation, the AP Basic Manual describes the language in

detail, and the AP Basic Extensions Reference for the 2700 Series Instruments

details the specific commands for this series.
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Chapter 6

Specifications

Analog Signal Outputs

All 2700 series configurations except SYS-2720 contain an ultra-low distortion

analog sine wave generator and two independent transformer-coupled output stages.

The SYS-2712 and SYS-2722 configurations also contain a dual-channel D/A signal

generator for enhanced capabilities. Option “BUR” adds analog-generated sine burst,

square wave, and noise signals. Option “IMD” adds analog-generated IMD test signals.

Unless otherwise noted, all specifications are valid only for outputs �150 µVrms

[420 µVpp].

Analog Output Characteristics

Source Configuration Selectable balanced, unbalanced, or CMTST
(common mode test).

Source Impedances

Balanced or CMTST 40 � (�1 �), 150 �
1

��1.5 �), or 600 � (�3 �).

Unbalanced 20 � (±1 �) or 600 � (±3 �).

Max Floating Voltage 42 Vpk (outputs are isolated from each other).

Output Current Limit Typically >80 mA.

Max Output Power into 600 �

Balanced +30.1 dBm (Rs = 40 �).

Unbalanced +24.4 dBm (Rs = 20 �).

Output Related Crosstalk

10 Hz–20 kHz � –120 dB or 5 µV, whichever is greater.

20 kHz–100 kHz � –106 dB or 10 µV, whichever is greater.

Low Distortion Sine Wave Generator

Frequency Range 10 Hz–204 kHz.

Frequency Accuracy

High-accuracy mode ±0.03%.

Fast mode ±0.5%.
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Frequency Resolution

High-accuracy mode 0.005%.

Fast mode 0.025 Hz, 10 Hz–204.75 Hz,
0.25 Hz, 205 Hz–2.0475 kHz,
2.5 Hz, 2.05 kHz–20.475 kHz,
25 Hz, 20.5 kHz–204 kHz.

Amplitude Range
2

Balanced <10 µV–26.66 Vrms [+30.7 dBu].

Unbalanced <10 µV–13.33 Vrms [+24.7 dBu].

Amplitude Accuracy ±0.7% [±0.06 dB] at 1 kHz.

Amplitude Resolution 0.003 dB or 0.05 µVrms, whichever is larger.

Flatness (1 kHz ref)

10 Hz–20 kHz ±0.008 dB (typically <0.003 dB).

20 kHz–50 kHz ±0.03 dB.

50 kHz–120 kHz ±0.10 dB.

120 kHz–200 kHz +0.2 / –0.3 dB.

Residual THD+N
3,4

At 1 kHz �(0.00025% + 1.0 µV) [–112 dB], 22 kHz BW
(valid only for analyzer inputs �8.5 Vrms).

20 Hz–20 kHz �(0.0003% + 1.0 µV) [–110.5 dB], 22 kHz BW,
�(0.0005% + 2.0 µV) [–106 dB], 80 kHz BW,
�(0.0010% + 5.0 µV) [–100 dB], 500 kHz BW.

10 Hz–100 kHz �(0.0040% + 5.0 µV) [–88 dB], 500 kHz BW.

Intermodulation Distortion Test Signals

with option “IMD”

SMPTE (or DIN)

LF Tone 40, 50, 60, 70, 100, 125, 250, or 500 Hz,
all ±1.5%.

HF Tone Range 2 kHz–200 kHz.

Mix Ratio 4:1 or 1:1 (LF:HF).

Amplitude Range
5

Balanced 30 µVpp–75.4 Vpp.

Unbalanced 30 µVpp–37.7 Vpp.

Amplitude Accuracy ±2.0% [±0.17 dB].

Residual IMD
6

0.0015% [–96.5 dB],
60 Hz + 7 kHz or 250 Hz + 8 kHz.
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20 Hz–50 kHz only. Decrease maximum output by a factor of 2 (–6.02 dB) for the full 10 Hz–204 kHz range.

3
System specification measured with the 2700 series analog analyzer set to the indicated measurement
bandwidth (BW). Generator amplitude setting must be �12 Vrms balanced or �6 Vrms unbalanced for
specified performance below 30 Hz. At higher amplitude settings generator THD derates to 0.0020% from
20 Hz–30 Hz.

4
Individual harmonics are typically <–130 dBc at 1 kHz, and <–120 dBc from 25 Hz to 20 kHz measured with a
passive notch filter and FFT analyzer.

5
Calibration with other amplitude units is based upon an equivalent sinewave having the same Vpp amplitude.

6
System specification measured with the 2700 series analog analyzer at any amplitude �200 mVrms.



CCIF and DFD

Difference Frequency 80, 100, 120, 140, 200, 250, 500 or 1 kHz;
all ±1.5%.

Center Frequency 4.5 kHz–200 kHz.

Amplitude Range
5

Balanced 30 µVpp–75.4 Vpp.

Unbalanced 30 µVpp–37.7 Vpp.

Amplitude Accuracy �3.0% [±0.26 dB].

CCIF Residual IMD
6

�0.0004% [–108 dB], 14 kHz+15 kHz
(odd order & spurious typ <0.05%).

DFD Residual IMD
6

�0.0002% [–114 dB], 14 kHz+15 kHz
(odd order & spurious typ <0.025%).

DIM (or TIM)

Squarewave Frequency 3.15 kHz (DIM-30 and DIM-100),
2.96 kHz (DIM-B); both �1%.

Sinewave Frequency 15 kHz (DIM-30 and DIM-100),
14 kHz (DIM-B).

Amplitude Range
4

Balanced 30 µVpp–75.4 Vpp.

Unbalanced 30 µVpp–37.7 Vpp.

Amplitude Accuracy ±2.0% [±0.17 dB].

Residual IMD
5

�0.0020% [–94 dB].

Special Purpose Signals

with option “BUR”

Sine Burst

Frequency Range 20 Hz–100 kHz.

Frequency Accuracy Same as Sinewave.

ON Amplitude Range
Accuracy, Flatness Same as Sinewave.

OFF Ratio Range 0 dB to –80 dB.

OFF Ratio Accuracy ±0.3 dB, 0 to –60 dB.

ON Duration 1 cycle–65535 cycles, or externally gated.

Interval Range 2 cycle–65536 cycles.

Square Wave

Frequency Range 20 Hz–20 kHz.

Frequency Accuracy Same as Sinewave.

Amplitude Range
4

Balanced 30 µVpp–37.7 Vpp.

Unbalanced 30 µVpp–18.8 Vpp.

Amplitude Accuracy ±2.0% [±0.17 dB] at 400 Hz.

Rise/fall time Typically 2.0 µs.
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Noise Signals

White Noise Bandwidth limited 10 Hz–23 kHz.

Pink Noise Bandwidth limited 20 Hz–200 kHz.

Bandpass Noise Approximately 1/3-octave (2-pole) filtered pink
noise, continuously tunable from 20 Hz–100 kHz.

Generator True random or pseudo-random.

Pseudo-Random Interval Typically 262 ms
(synchronized to the analyzer 4/s reading rate).

Amplitude Range
5

(Approximate calibration only).

Balanced 30 µVpp–37.7 Vpp.

Unbalanced 30 µVpp–18.8 Vpp.

Graphs of Typical Analog Generator Performance

Chapter 6: Specifications Analog Signal Outputs

52 Getting Started with Your 2700 Series Instrument

-120

-60

-115

-110

-105

-100

-95

-90

-85

-80

-75

-70

-65

d
B

0.0001

0.1

0.0002

0.0005

0.001

0.002

0.005

0.01

0.02

0.05

%

10 20k20 50 100 200 500 1k 2k 5k 10k
Hz

Figure 31. Typical system

THD+N versus

Frequency at 2 Vrms

(analog sine).
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Figure 32. Typical system

THD+N versus amplitude at

1 kHz. Lower trace is with

22 kHz bandwidth limiting.

Middle trace is with 80 kHz.
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Figure 33. Typical residual
THD+N spectrum at 1 kHz,
2 Vrms. (32768 point FFT of
notch filter output, Sample
Rate = 65.536 ks/s, 16
averages).

-160

-80

-150

-140

-130

-120

-110

-100

-90

d
B

0 120k10k 20k 30k 40k 50k 60k 70k 80k 90k 100k 110k
Hz

Figure 34. Typical residual
THD+N spectrum at 20 kHz,
2 Vrms. (32768 point FFT of
notch filter output, Sample
Rate = 262 ks/s, 16
averages).

Figure 35. Typical analog

system flatness at 2 Vrms

signal level (measured with

the analog analyzer’s Level

meter, dc input coupling).



D/A Generated Analog Signals

Available only in the SYS-2720 and SYS-2722 configurations. Except for arbitrary

and Pass Thru waveforms, the digitally generated analog output signals and the

embedded output signals are independently selectable and concurrently available. If

both analog and digital outputs are selecting arbitrary waveform, it must be the same

one. If Pass Thru waveforms are selected for both analog and digital generators, they

must be at the same sample rate.

Common Specifications

Sample Rate

Sine, IMD signals fixed at 65.536 ks/s or 131.072 ks/s.

Other signals 8 ks/s–108 ks/s variable,
or fixed at 65.536 ks/s or 131.072 ks/s.

Frequency Accuracy �0.0002% [2 PPM] internal reference, lockable to
external reference.

D/A Resolution 24-bit sigma-delta.

“SINE (D/A)” Signal Family

The Sine family includes “Normal,” “Var Phase,” “Stereo,” “Dual,” “Shaped Burst,”

and “EQ Sine.” Normal and EQ Sine produce a monaural signal with the best (lowest)

residual THD+N performance. EQ Sine varies the amplitude in accordance with a

selected EQ file. Var Phase produces the same sine wave in both channels but with

settable phase offset. Stereo provides sine waves of independently settable frequency in

each channel (phase is random if both frequencies are set equal). Dual produces a

monaural test signal containing a mixture of two sine waves of independently settable

frequency and amplitude ratio. Shaped Burst produces a monaural sine burst signal

with a raised cosine amplitude envelope (see Figure 60 on page 75).

Frequency Ranges 10 Hz–30 kHz (65.536 ks/s), or
10 Hz–60 kHz (131.072 ks/s).

Frequency Resolution Sample Rate � 2
23

.
[0.0078 Hz in the 30 kHz range].

Flatness (1 kHz ref)

20 Hz–20 kHz �0.01 dB.

10 Hz–30 kHz ±0.03 dB.

30 kHz–50 kHz ±0.10 dB (typically –0.5 dB at 60 kHz).

THD+N
7

(20Hz–20kHz)

30 kHz range 0.0007% [–103 dB].

60 kHz range 0.0014% [–97 dB].

Variable Phase Range –180.0 to +179.9 deg.

Dual-Sine Ratio Range 0 dB to –100 dB, usable to –138 dB.

Shaped Burst Interval 2 cycle–65536 cycles.

Shaped Burst On Time 1 to (number of interval cycles minus 1).
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7
System specification measured with the 2700 series analog analyzer set for a 22 kHz measurement BW.



“IMD (D/A)” Signal Family

SMPTE/DIN Test Signal

LF Tone 40 Hz–500 Hz.

HF Tone 2.00 kHz–50 kHz.

Mix Ratio 4:1 or 1:1 (LF:HF).

Residual IMD
7

�0.0010% [–100 dB], 60/7 kHz or 250/8 kHz.

CCIF/DFD Test Signal

Difference Frequency 80 Hz–2 kHz.

Center Frequency 4.50 kHz to >50 kHz.

Residual CCIF IMD
8

CCIF: �0.0004% [–108 dB], 14 kHz/15 kHz.
DFD: �0.0002% [–114 dB], 14 kHz/15 kHz.

DIM Test Signal

Squarewave Frequency 3.15 kHz for DIM30 and DIM100,
2.96 kHz for DIMB.

Sinewave Frequency 15.00 kHz for DIM30 and DIM100,
14.00 kHz for DIMB.

Residual IMD
8

�0.0020% [–94 dB].

Other Signals

Arbitrary and Multitone Waveforms (“Arb Wfm”)

Signal Determined by the associated file specified in the
panel drop-down box.

Frequency Range 20 Hz to 47% of Sample Rate.

Length 256 points–16384 points per channel. Utility is
provided to prepare waveform from frequency,
amplitude, and phase data.

Frequency Resolution Sample Rate ÷ Length
[2.93 Hz at 48 ks/s for a waveform 16384 points
in length].

Maximum Number of Tones (Length / 2) –1 [8191 for Length = 16384].

Maximum Length Sequence (“MLS”)

Sequences Four pink, four white.

Sequence Length “32k” (32767) or “128k” (131071).

Frequency Range 10 Hz to 43% of Sample Rate, ±0.1 dB.

Special Signals

Polarity Sum of two sine waves phased for reinforcement
with normal polarity.

Pass Thru Passes the embedded audio signal from the rear
panel Reference Input. Ratio of reference rate to
output Sample Rate may not exceed 8:1.
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8
System specification measured with the 2700 series analog analyzer at any voltage �200 mVrms.



Squarewave

Frequency Range 20 Hz–20.0 kHz.

Rise Time Typically 2.0 µs.

Noise Signal

Pseudo-random white
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Analog Analyzer

All 2700 series configurations except SYS-2720 contain an input module with two

independent auto-ranging input stages, each having its own level (rms) and frequency

meters; a phase meter; plus a single channel multi-function analyzer module providing

additional signal processing and gain stages. Standard analog analyzer functions

include amplitude and noise (both wideband and selective), THD+N, and crosstalk.

The SYS-2712 and SYS-2722 configurations add dual-channel A/D converters for

FFT and other special forms of analysis. Option “IMD” adds inter-modulation

distortion measurement capability. Option “W&F” adds wow & flutter measurement

capability.

Unless otherwise noted, all specifications assume dc coupling, rms detection, and

auto-ranging operation.

Analog Input Characteristics

Input Ranges 40 mV–160 V in 6.02 dB steps.

Maximum Rated Input 230 Vpk, 160 Vrms (dc to 20 kHz),
overload protected in all ranges.

Input Impedance

Balanced 200 k� / 95 pF (differential).

Unbalanced 100 k� / 185 pF.

Terminations Selectable 600 � or 300 �, each �1%,
1 Watt [+30 dBm] maximum power.

CMRR
9

40 mV–2.5 V ranges �80 dB, 10 Hz–20 kHz.

5 V and 10 V ranges �65 dB, 10 Hz–20 kHz.

20 V–160 V ranges �50 dB, 10 Hz–1 kHz.

Input Related Crosstalk

10 Hz–20 kHz � –140 dB or 1 µV, whichever is greater.

20 kHz–100 kHz � –126 dB or 2.5 µV, whichever is greater.

Level Meter Related

Measurement Range 5 mV–160 V for specified accuracy and flatness,
usable to <100 µV.

Resolution (full scale)
10

4/s and 8/s 1/40,000 [0.00022 dB].

16/s 1/20,000 [0.00043 dB].

32/s 1/10,000 [0.00087 dB].

64/s 1/5,000 [0.0017 dB].

128/s 1/2,500 [0.0035 dB].

Accuracy (1 kHz) �0.5% [�0.05 dB].
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9
Not valid below 50 Hz with ac coupling.

10
Resolution within a given range is equal to its full scale value multiplied by the fraction indicated for the
selected reading rate. (Example: 40 mV input range reading resolution = 4 µV, using the 32/s reading rate).
Numerical displays using a dB unit are rounded to the nearest 0.001 dB.



Flatness (1 kHz ref)
11

20 Hz–20 kHz �0.008 dB (typically <0.003 dB).

15 Hz–50 kHz �0.03 dB.

10 Hz–120 kHz �0.10 dB.

120 kHz–200 kHz +0.2 / –0.3 dB (typically <–0.5 dB at 500 kHz).

Frequency Meter Related

Measurement Range 10 Hz–500 kHz.

Accuracy �0.0006% [�6 PPM].

Resolution 6 digits + 0.000244 Hz.

Minimum Input 5 mV.

Phase Measurement Related

Measurement Ranges �180, –90 / +270, or 0 / +360 deg.

Accuracy
12

10 Hz–5 kHz ±0.5 deg.

5 kHz–20 kHz ±1 deg.

20 kHz–50 kHz ±2 deg.

Resolution 0.1 deg.

Minimum Input 5 mV, both inputs.

Wideband Amplitude/Noise Function

Measurement Range <1 µV–160 Vrms.

Accuracy (1 kHz) ±1.0% [±0.09 dB].

Flatness (1 kHz ref)
11

20 Hz–20 kHz �0.02 dB.

15 Hz–50 kHz �0.05 dB.

50 kHz–120 kHz �0.15 dB.

120 kHz–200 kHz +0.2 dB / –0.3 dB (typically < –3 dB at 500 kHz).
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11
Derate flatness above 5 kHz by an additional �0.02 dB in the 20 V, 40 V, 80 V, and 160 V input ranges.

12
Both analyzer input channels must have same coupling (ac or dc) selection. Accuracy is valid for any input
signal amplitude ratio up to �30 dB.



Bandwidth Limiting Filters –see Figure 36

LF –3 dB <10 Hz,
22 Hz per IEC468 (CCIR),
100 Hz �5% (3-pole), or
400 Hz �5% (3-pole).

HF –3 dB 22 kHz per IEC468 (CCIR),
30 kHz �5% (3-pole),
80 kHz �5% (3-pole), or
>500 kHz.

Optional Filters up to 7 (see section on Option Filters).

Detection RMS (� = 25 ms or 50 ms),
Average,
QPk per IEC468 (CCIR),
Pk (pseudo-peak), or
S-Pk (0.7071 × Pk reading).

Residual Noise

22 Hz–22 kHz BW �1.0 µV [–117.8 dBu].

80 kHz BW �2.0 µV [–111.8 dBu].

500 kHz BW �6.0 µV [–103.8 dBu].

A-weighted �0.5 µV [–123.8 dBu].

CCIR-QPk �2.5 µV [–109.8 dBu].

Bandpass Amplitude Function

Tuning Range (fo) 10 Hz–200 kHz.

Tuning Accuracy ±2%.

Bandpass Response 1/3-octave class II (4-pole),
< –32 dB at 0.5 fo and 2.0 fo.

Accuracy (at fo) ±0.3 dB, 20 Hz–120 kHz.

Residual Noise

10 Hz–5 kHz �0.25 µV [–130 dBu].

5 kHz–20 kHz �0.5 µV [–124 dBu].

20 kHz–200 kHz �1.5 µV [–114 dBu].

Bandreject Amplitude Function

Tuning Range (fo) 10 Hz–200 kHz.

Tuning Accuracy ±2%.

Bandreject Response typically –3 dB at 0.73 fo & 1.37 fo,
–20 dB at fo ±10%,
–40 dB at fo ±2.5%.

Accuracy ±0.3 dB, 20 Hz–120 kHz
(excluding 0.5 fo–2.0 fo).
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Figure 36. Typical

responses of the standard

band-limiting filters.



THD+N Function

Fundamental Range 10 Hz–200 kHz.

Measurement Range 0%–100%.

Accuracy ±0.3 dB, 20 Hz–120 kHz harmonics.

Measurement Bandwidth

LF –3 dB <10, 22, 100, or 400 Hz.

HF –3 dB 22k, 30k, 80k, or >500 kHz
(Option filter selection also affects bandwidth).

Residual THD+N
13

At 1 kHz �(0.00025% + 1.0 µV) [–112 dB], 22 kHz BW
(valid only for analyzer inputs �8.5 Vrms).

20 Hz–20 kHz �(0.0003% + 1.0 µV) [–110.5 dB], 22 kHz BW,
�(0.0005% + 2.0 µV) [–106 dB], 80 kHz BW,
�(0.0010% + 5.0 µV) [–100 dB], 500 kHz BW .

10 Hz–100 kHz �(0.0040% + 5.0 µV) [–88 dB], 500 kHz BW .

Minimum Input 5 mV for specified accuracy, usable to <100 µV
with fixed notch tuning.

Notch Tuning Modes Counter Tuned,
Sweep Track,
AGen-Track (analog generator),
DGen-Track (digital generator), or
Fixed (set by direct entry).

Notch Tracking Range ±2.5% from fixed setting.

Crosstalk Function

Frequency Range 10 Hz–200 kHz.

Accuracy
14

±0.4 dB, 20 Hz–120 kHz.

Residual Crosstalk
14

10 Hz–20 kHz � –140 or 1 µV.

20 kHz–100 kHz � –126 dB or 2.5 µV .

IMD Measurements

with option “IMD”

Option “IMD” adds the capability to measure intermodulation distortion (IMD)

using three of the most popular techniques. The demodulated IMD signal can also be

selected for FFT analysis in SYS-2712 and SYS-2722 configurations.

SMPTE (DIN) IMD Function

Test Signal Compatibility Any combination of 40 Hz–250 Hz (LF) and
2 kHz–100 kHz (HF) tones, mixed in any ratio
from 0:1 to 8:1 (LF:HF).

IMD Measured Amplitude modulation products of the HF tone.
–3 dB measurement bandwidth is typically
20 Hz–750 Hz.
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13
System specification measured with the 2700 series analog generator and the analog analyzer set to the
indicated measurement bandwidth (BW). Generator amplitude setting must be �12 Vrms balanced or
�6 Vrms unbalanced for specified system performance below 30 Hz. At higher amplitude settings generator
THD derates to 0.0020% from 20 Hz–30 Hz.

14
Uses the 1/3-octave bandpass filter to enhance the measured range in the presence of wideband noise.
Alternate (interfering) channel input must be � 5 mV.



Measurement Range 0%–20%.

Accuracy ±0.5 dB.

Residual IMD
15

�0.0015% [–96.5 dB], 60/7 kHz or 250/8 kHz.

CCIF and DFD IMD Functions

Test Signal Compatibility Any combination of equal amplitude tones from
4 kHz–100 kHz spaced 80 Hz–1 kHz.

IMD Measured

CCIF 2
nd

order difference frequency product relative to
the amplitude of either test tone.

DFD u2 (2nd order difference frequency product)
per IEC 268-3 (1986).

Measurement Range 0%–20%.

Accuracy ±0.5 dB.

Residual IMD
15

CCIF �0.0004% [–108 dB], 14 kHz + 15 kHz,
DFD �0.0002% [–114 dB], 14 kHz + 15 kHz.

DIM (TIM) IMD Function

Test Signal Compatibility 2.96 kHz–3.15 kHz squarewave mixed with
14 kHz–15 kHz sine wave (probe tone).

IMD Measured
16

u4 and u5 per IEC 268-3 (1986).

Measurement Range 0%–20%.

Accuracy ±0.7 dB.

Residual IMD15 �0.0020% [–94 dB].

Wow & Flutter Measurements

with option “W&F”

Option “W&F” adds the capability to make both conventional wow & flutter and

scrape flutter measurements (using the technique developed by Dale Manquen of Altair

Electronics, Inc.). The demodulated W&F signal can also be selected for FFT analysis

in SYS-2712 and SYS-2722 configurations.

Test Signal Compatibility

Normal 2.80 kHz–3.35 kHz.

“High-band” 11.5 kHz–13.5 kHz.

Measurement Range 0%–1.2%.

Accuracy (4 Hz) ±(5% of reading + 0.0005%).

Detection Modes IEC/DIN (quasi-peak per IEC-386),
NAB (average),
JIS (per JIS 5551).
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15
System specification measured with the 2700 series analog generator at any valid input level �200 mVrms.

16
IEC 268-3 defines nine possible DIM products. The 2700 series IMD option analyzer is sensitive only to the

u4 and u5 products using the simplified measurement technique proposed by Paul Skritek. DIM measurements
using this technique will typically be 6 dB–8 dB lower (better) than the results obtained using FFT-based
techniques which sum all nine products.



Response Selections

Weighted 4 Hz bandpass per IEC/DIN/NAB.

Unweighted 0.5 Hz–200 Hz.

Scrape
17

200 Hz–5 kHz.

Wideband
17

0.5 Hz–5 kHz.

Residual W+F

Weighted �0.001%.

Unweighted �0.002%.

Scrape or Wideband �0.005%.

Minimum Input 5 mV, 20 mV for specified residual.

Settling Time

IEC/DIN or NAB Typically 3 seconds–6 seconds.

JIS Typically 15 seconds–20 seconds.
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17
Operational only with high-band test signals (11.5 kHz–13.5 kHz). Upper –3 dB rolloff is typically 4.5 kHz using
12.5 kHz.



Option Filters

Up to seven option filters can be installed in the analog analyzer for weighted noise

or other special measurements. Only one option filter may be enabled at a time, and it

is cascaded with the standard bandwidth limiting filters. The following tables list only

the most popular types. Consult Audio Precision for custom designs.

Weighted Noise Measurement

FIL-AWT “A” weighting per IEC Rec 179. –see Figure 37

FIL-CCR Weighting per IEC468 (CCIR) and DIN 45404
(Also for CCIR/ARM). –see Figure 38

FIL-CIT Weighting per CCITT Rec P53. –see Figure 39

FIL-CMS “C-message” per BSTM 41004 and ANSI/IEEE
Std 743-1984. –see Figure 40

FIL-CWT “C” weighting per IEC Rec 179. –see Figure 41
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Figure 37. FIL-AWT. ANSI-IEC “A”

Weighting Filter.

C C IR -4 6 8 -4

D O L B Y

Figure 38. FIL-CCR. IEC468 (CCIR)/ DIN

45404 Noise Weighting Filter.

Figure 39. FIL-CIT. CCITT P53 Noise

Weighting Filter.

Figure 40. FIL-CMS.C-Message Weighting

Filter (ANSI/IEEE 743-1984).

Figure 41. FIL-CWT. “C”

Weighting (IEC-179).



Precision De-emphasis Family

FIL-D50 50 µs �1%. –see Figure 42

FIL-D50E 50 µs �1% + 15.625 kHz notch.

FIL-D50F 50 µs �1% + 19.0 kHz notch. –see Figure 43

FIL-D75 75 µs �1%. –see Figure 44

FIL-D75B 75 µs �1% + 15.734 kHz notch. –see Figure 45

FIL-D75F 75 µs �1% + 19.0 kHz notch. –see Figure 46
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Figure 42. FIL-D50.50 µs De-emphasis

Filter.

Figure 43. FIL-D50F. 50 µs with 19 kHz

(FM) notch De-emphasis Filter.

Figure 44. FIL-D75. 75 µs De-emphasis

Filter.

Figure 45. FIL-D75B. 75 µs with 15.734

kHz (NTSC) notch De-emphasis Filter.

Figure 46. FIL-D75F. 75 µs with 19 kHz

(FM) notch De-emphasis Filter.



Very Sharp Cutoff Low-Pass Filter Family

FLP-B20K ±0.1 dB, 10 Hz–20 kHz; >60 dB attenuation at
24 kHz and higher. Complies with AES17.

–see Figure 47

FLP-B40K ±0.1 dB, 10 Hz–40 kHz; >60 dB attenuation at
48 kHz and higher. Complies with AES17.

General Purpose Low-Pass

FLP-300 300 Hz ±3%, 5-pole.

FLP-400 400 Hz �3%, 5-pole.

FLP-500 500 Hz �3%, 5-pole.

FLP-1K 1 kHz �3%, 5-pole. –see Figure 48

FLP-3K 3 kHz �3%, 7-pole.

FLP-4K 4 kHz �3%, 7-pole.

FLP-8K 8 kHz �3%, 7-pole. –see Figure 49

FLP-50K 50 kHz �5%, 3-pole.

General Purpose High-Pass

FHP-70 70 Hz �3%, 8-pole.

FHP-400 400 Hz �3%, 9-pole. –see Figure 50

FHP-2K 2 kHz �3%, 9-pole.
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Figure 47. FLP-B20K

“Brick Wall” 20 kHz low

pass filter. Complies with

requirements of AES17

for D/A converter

THD+N measurements.

Figure 48. 1 kHz 5-pole Low Pass Filter. Figure 49. 8 kHz 7-pole Low Pass Filter.

Figure 50. FHP-

400. 400 Hz 9-

pole High Pass

Filter.



1/3-Octave (Class II) Bandpass Family

Family Response Class II (4-pole)
�0.2 dB from 0.97 fo–1.03 fo ;
<–12 dB at 0.8 fo and 1.25 fo ;
<–32 dB at 0.5 fo and 2.0 fo. –see Figure 51

FBP-120 fo = 120 Hz.

FBP-250 fo = 250 Hz.

FBP-300 fo = 300 Hz.

FBP-400 fo = 400 Hz.

FBP-500 fo = 500 Hz.

FBP-600 fo = 600 Hz.

FBP-800 fo = 800 Hz.

FBP-1000 fo = 1.00 kHz.

FBP-1200 fo = 1.20 kHz.

FBP-1500 fo = 1.50 kHz.

FBP-2000 fo = 2.00 kHz.

FBP-3000 fo = 3.00 kHz.

FBP-4000 fo = 4.00 kHz.

FBP-5000 fo = 5.00 kHz.

FBP-6000 fo = 6.00 kHz.

FBP-8000 fo = 8.00 kHz.

FBP-10000 fo = 10.0 kHz.

FBP-12500 fo = 12.5 kHz.

FBP-15000 fo = 15.0 kHz.

FBP-20000 fo = 20.0 kHz.

FBP-30000 fo = 30.0 kHz.
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Figure 51. FBP-xxxx.

Normalized Response of 1/3-

Octave Band Pass Filters



Receiver Testing

FIL-RCR 200 Hz–15 kHz + 19.0 kHz notch. –see Figure 52

FIL-IECR 20 Hz–15 kHz + 15.625 kHz notch –see Figure 53

Miscellaneous

FBP-500X High-Q 500 Hz bandpass for CD DAC linearity
measurements. –see Figure 54

FIL-USR Kit for building custom filters.
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Figure 52. FIL-RCR. 200 Hz to 15 kHz with

19 kHz (FM) notch.

Figure 53. FIL-IECR. 20 Hz to 15 kHz with

15.625 kHz (PAL) notch.

Figure 54. FBP-500X. High-

Q 500 Hz Band Pass Filter

(for CD linearity testing).



Option S-AES17

Option S-AES17 adds the capability to insert a 20 kHz or 40 kHz low-pass filter

following the selected analog input preamplifier, but before any signal processing

within the analog analyzer. It enables accurate noise and THD+N measurements of

sigma-delta converters and switching power amplifiers that contain large amounts of

unwanted energy above the normal audio bandwidth.

High performance sigma-delta converters and switching power

amplifiers often contain out-of-band energy that can exceed the

in-band audio signal. Standard bandwidth limiting and noise

weighting filters will not give accurate measurements due to

their relatively low roll-off rates.

Option S-AES17 also includes the FLP-B20K and FLP-B40K option filters. These

have been designed to work in tandem with the selectable pre-analyzer filters to

provide THD+N measurements in accordance with AES17-1998.

Pre-Analyzer Filter Response

(also affects the LEVEL and FREQUENCY meters of the selected channel)

20 kHz ±0.10 dB, 10 Hz–20 kHz
(typ –3 dB at 25 kHz, <–60 dB above 60 kHz).

40 kHz ±0.10 dB, 10 Hz–40 kHz
(typ –3 dB at 50 kHz, <–60 dB above 120 kHz).

Residual THD+N (1 kHz)

“20k AES17” mode �(0.00030% + 1.0 µV) [–110.5 dB].

“40k AES17” mode �(0.00040% + 1.4 µV) [–108 dB].
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Figure 55. Typical response of 20 kHz “pre-analyzer” filter.



DSP Analysis of Analog Signals

Available only in SYS-2712 and SYS-2722 configurations. Signals connected to the

analog analyzer input connector may be routed through stereo A/D converters for

enhanced analysis capabilities. There are two selectable converters. The high-resolution

converter (“HiRes A/D”) is optimized for signal analysis and FFT displays up to 30

kHz. It offers the best residual noise and distortion performance. The high bandwidth

converter (“HiBW A/D”) is optimized for signal analysis up to 120 kHz.

The term “fs” refers to sample frequency (also called sample rate), in hertz.

High Resolution Converter

A/D Resolution 24-bit sigma-delta.

Sample Rate (fs) 8 ks/s–108 ks/s variable; or 65.536 ks/s fixed.

Flatness (1 kHz ref) �0.01 dB to 045. � SRor 20 kHz, whichever is
lower.

Alias Rejection
18

typically >115 dB for signals >0.554 x fs.

Distortion –105 dB for fs �65.536 ks/s,
–102 dB for fs up to 100 ks/s.

High Bandwidth Converter

A/D Resolution 16-bit sigma-delta.

Sample Rate (fs) 16 ks/s–200 ks/s variable; or 131.072 ks/s, or
262.144 ks/s fixed.

Flatness (1 kHz ref) �0.01 dB to 20 kHz,
�0.10 dB to 120 kHz (262.144 ks/s).

Alias Rejection
18

typically >85 dB for signals > 0.540 x fs.

Distortion –92 dB for fs �200 ks/s,
–90 dB with fs = 262.144 ks/s.

FFT Signal Analyzer

(With “FFT” DSP program)

Acquisition Length 800 samples to 4 M samples in 15 steps.

Transform Length 256–32768 samples in binary steps.

Processing 48 bit.

Amplitude Accuracy �0.09 dB, 20 Hz–20 kHz,
Flat-top or Move to Bin Center windows.

Averaging 1–4096 averages in binary steps. Averaging is
power-based (frequency domain), or
synchronous (time domain).

Waveform Display Modes

Time Domain Normal, Interpolate, Peak or Max.
Frequency Domain Peak pick (highest bin amplitude is displayed

between the requested graph points).

Frequency Display Modes Peak pick, individual bin.

Chapter 6: Specifications DSP Analysis of Analog Signals

68 Getting Started with Your 2700 Series Instrument

18
Alias rejection is provided by digital filters within the A/D converters.



Windows Blackman-Harris (4-term with –92 dB sidelobes),
–see Figures 56 and 37. Hann,

Flat-top,
Equiripple (AP design with –160 dB sidelobes),
None,
None, move to bin center,
Hamming,
Gaussian,
Rife-Vincent 4-term,
Rife-Vincent 5-term.

Move to bin center Window

Frequency Range �4% of input frequency, 7
th

FFT bin (low limit),
to 0.45 x fs (high limit).

Spurious Products <–120 dB.

DSP Audio Analyzer

with “Analyzer” DSP program

Wideband Level/Amplitude

Accuracy (1 kHz) �0.09 dB [�1.0%]

Frequency Range <10 Hz to 45% of Sample Rate
[10 Hz–21.6 kHz at 48 ks/s].

High pass Filters <10 Hz 4-pole,
22 Hz 4-pole,
100 Hz 4-pole,
400 Hz 4-pole (4-pole Butterworth or 10-pole
elliptic if no other filters are enabled).

Low pass Filters FS/2 (maximum bandwidth),
20 kHz (6-pole elliptic),
15 kHz (6-pole elliptic).

Weighting Filters ANSI-IEC “A” weighting, per IEC Rec 179,
CCIR QPk per IEC468 (CCIR),
CCIR RMS per AES17,
C-message per IEEE Std 743-1978,
CCITT per CCITT Rec. O.41,
“F” weighting corresponding to 15 phon loudness
contour, –see Figure 58
HI-2 Harmonic weighting.
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Narrow Band Amplitude

Frequency Range <10 Hz to 47% of Sample Rate
[10 Hz–22.56 kHz at 48 ks/s].

Filter Shape 10-pole, Q=19 (BW = 5.3% of fo). –see Figure 59

THD+N Measurements

Frequency Range <10 Hz to 47% of Sample Rate
[10 Hz–22.56 kHz at 48 ks/s].

High pass Filters <10 Hz (4-pole),
22 Hz (4-pole),
100 Hz (4-pole),
400 Hz (4-pole Butterworth).

Low pass Filters FS/2 (maximum bandwidth),
20 kHz (6-pole elliptic),
15 kHz (6-pole elliptic).

Weighting Filters ANSI-IEC “A” weighting, per IEC Rec 179,
CCIR QPk per IEC468 (CCIR),
CCIR RMS per AES17,
C-message per IEEE Std 743-1978,
CCITT per CCITT Rec. O.41,
“F” weighting corresponding to 15 phon loudness
contour, –see Figure 29
HI-2 Harmonic weighting.

Figure 58. Digital Analyzer

F-weighting curve.

Figure 59. Digital Domain

Bandpass filter response.
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Frequency Measurements

Range <10 Hz to 47% of Sample Rate
[10 Hz–23.0 kHz at 48 ks/s].

Accuracy �0.01% of reading or 0.0001% of Sample Rate,
whichever is greater.

Resolution 0.003% of reading or 0.0001% of Sample Rate,
whichever is greater.

Phase Measurements

Measurement Ranges �180, –90/+270, or 0/+360 degrees.

Accuracy
19

10 Hz–5 kHz �0.5 degree.

5 kHz–20 kHz �1 degree.

20 kHz–50 kHz �2 degrees.

Resolution 0.01 degree.

Minimum Input 1 mV, both inputs.

SMPTE IMD Measurements

Test Signal Compatibility Any combination of 40 Hz–250 Hz (LF) and 2 kHz
to 45% of Sample Rate (HF) tones, mixed in any
ratio from 1:1 to 5:1 (LF:HF).

IMD Measured Amplitude modulation products of the HF tone.
–3dB measurement bandwidth is 10 Hz–750 Hz.

Measurement Range 0%–20%.

Accuracy �0.5 dB.

Residual IMD
20

�0.0025%, 60 + 7 kHz or 250 + 8 kHz.

Quasi-Anechoic Acoustical Tester

With “MLS” DSP program

Signals Four pink sequences, four white sequences.

Frequency Range (Sample Rate � 2000) to (Sample Rate � 2).

Frequency Resolution (Max) 1.465 Hz at 48.0 ks/s.

Acquisition Length 32767 or 131071 samples.

FFT Length 32768.

Energy Time Windows half Hann,
Hann,
<240 Hz to >8 kHz,
<120 Hz to >16 kHz.

Time Windows <5%,
(percent of data record to <10%,
transition from 0 to full <20%,
amplitude) <30%.

Averaging 1–4096 averages in binary steps. Averaging
algorithm is synchronous.
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19
Both analog analyzer input channels must have same coupling (ac or dc) selection, and both DSP analyzer

input channels must have same coupling (ac or dc) selection. Accuracy is valid for any input signal amplitude
ratio up to ±30 dB. Upper frequency range limited to 45% of Sample Rate.

20
System specification measured with the 2700 series analog generator. Valid for input levels �200 mVrms.



Multitone Audio Analyzer

With “FASTTEST” DSP program

Acquisition Length 512–32768 samples in binary steps.

Transform Length 512–32768 samples in binary steps.

Processing 48 bit.

Measurements Level vs frequency (Response),
Total distortion vs frequency,
Noise vs frequency,
Phase vs frequency,
Crosstalk vs frequency,
Masking curve.

Frequency Resolution (Sample Rate � Transform Length)
[1.465 Hz with fs = 48 ks/s
& Transform Length = 32768].

Frequency Correction Range �3%.

Distortion �–115 dB.
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Digital Signal Generator

Available only in the SYS-2720 and SYS-2722 configurations. The 2700 series

digital generator consists of a DSP signal generator, hardware impairment generators

and processing (for example, variable risetime and induced jitter), and digital output

stages supporting the most popular formats.

Except for arbitrary and Pass Thru waveforms, the embedded output signals and the

digitally generated analog output signals are independently selectable and concurrently

available. If both digital and analog outputs are selecting arbitrary waveform, it must be

the same one. If Pass Thru waveforms are selected for both analog and digital

generators, they must be at the same sample rate.

Interface Signal Characteristics

Output Formats Balanced XLR (AES/EBU per AES3-r1997),
Dual Connector XLR,
Unbalanced BNC (SPDIF-EIAJ per IEC-60958),
Dual Connector BNC,
Optical (Toslink

®
) per IEC-60958,

General purpose parallel, or
Serial interface to chip via optional PSIA-2722.

Sample Rate (“SR”)

Range

Electrical Formats 28 kHz–200 kHz for fully specified performance;
usable from 8 kHz–216 kHz.

Optical Format 28 kHz–108 kHz for fully specified performance;
usable down to 8 kHz. Upper rate is limited by
Toslink

®
technology.

Resolution <0.0001 Hz.

Accuracy �0.0002% [�2 PPM],
lockable to external reference.

Output Amplitude

Balanced (XLR)

Range 0 Vpp–10.20 Vpp into 110 �.
Output is unspecified above 8.00 Vpp if
SR >108 kHz, or above 5.00 Vpp if SR <16 kHz.

Resolution 40 mV, 4 mV below 1 Vpp.

Accuracy �(10% + 80 mV)	

Unbalanced (BNC)

Range 0 Vpp–2.55 Vpp into 75 �.
Output is unspecified above 2.00 Vpp if
SR >108 kHz, or above 1.25 Vpp if SR <16 kHz.

Resolution 10 mV, 1 mV below 0.25 Vpp.

Accuracy �(8% + 20 mV)	

Optical Fixed.

Output impedance

Balanced (XLR) Nominally 110 �	

Unbalanced (BNC) Nominally 75 �	

Channel Status Bits Full implementation per IEC 60958, English
language decoded, Professional or consumer or
hex formats; independent in each channel.

User Bits Set to 0.

Validity Flag Selectable-set or cleared, common to both
outputs.

Digital Signal Generator Chapter 6: Specifications

Getting Started with Your 2700 Series Instrument 73



Interface Signal Impairments

Variable Rise/Fall Time 12 ns–100 ns, �(10% + 2 ns).

Cable Simulation Approximates the signal degradation of
40 m–100 m of typical digital audio cable.

Induced Jitter (sine wave)

Frequency Range
21

2 Hz–200 kHz.

Amplitude Range
21

0 UI–0.127 UI in 0.0005 UI steps,
0.13 UI–1.27 UI in 0.005 UI steps,
1.3 UI–12.7 UI in 0.05 UI steps.

Accuracy �(10% + 2.0 ns), peak calibrated.

Flatness
22

�1 dB, 100 Hz–50 kHz.

Residual Jitter
23

�600 ps (700 Hz–100 kHz analyzer bandwidth),
�1.0 ns (50 Hz–100 kHz analyzer bandwidth).

Spurious Jitter Products Typically 30 dB below jitter signal or 0.001 UI,
whichever is larger.

Normal Mode Noise

Waveform Pseudo-random pulse train.

Balanced (XLR) 0 Vpp–2.55 Vpp in 10 mV steps, �(10% +
100 mV).

Unbalanced (BNC) 0 mVpp–635 mVpp in 2.5 mV steps, �(10% +
25 mV).

Common Mode Signal Applies to Balanced (XLR) outputs only.

Frequency Range 20 Hz–100 kHz.

Amplitude Range 0 Vpp–20.4 Vpp in 80 mV steps,
�(10% + 160 mV).

Delay from rear panel –64 UI to +63.5 UI in 0.5 UI steps.
Reference Output

Embedded Signal Generation

Encoding is selectable 8–24 bit Linear, µ-Law, or A-Law

Sine Family Common Characteristics

Waveforms Sine, Sine Burst (rectangular envelope), Variable
Phase Sine (two sine waves of same frequency
but settable phase), Stereo Sine (independent
frequency and amplitude in each channel), Dual
Sine (sum of two sine waves with variable ratio),
Sine + Offset, and Shaped Sine Burst (raised
cosine envelope).

Frequency Range 10 Hz to 47% of Sample Rate
[22.56 kHz at 48 ks/s].

Frequency Resolution Sample Rate � 2
23

[0.006 Hz at 48 ks/s].

Flatness ±0.001 dB.

Harmonics/Spurious Products �0.000001% [–160 dB].
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21
Combinations of jitter amplitude and frequency must not result in greater than 50% reduction in transmitted bit
width.

22
System specification at 32, 44.1, 48, 88.2, 96, 176.4, and 192 ks/s. Flatness of the jitter generator will exhibit
degradation at other sample rates.

23
Applies to balanced and unbalanced signal formats only. Specification subject to the following conditions: (1)
all jitter generator impairments must be turned off or disabled including the delay from reference output feature,
(2) the digital input signal must be � 1.5 Vpp (AES/EBU) or � 300 mVpp (SPDIF-EIAJ) and have a risetime
� 20 ns. Jitter via the optical path may be considerably worse with embedded audio or dither enabled.



Variable Phase Sine Wave

Phase Range �180 deg.

Phase Resolution 0.01 deg.

Sine + Offset

Offset Amplitude Sine amplitude + |offset amplitude| �100% FS.

Sine Burst and Shaped Sine Burst

Envelope Rectangular for Sine Burst,
Raised cosine for Shaped Burst. –see Figure 60

Interval 2 cycles–65536 cycles.

Burst On 1 to (number of Interval cycles minus 1).

Square Wave

Frequency Range �1 Hz to 1/6 Sample Rate. Frequencies are
limited to even integer sub-multiples of the
Sample Rate.

Even Harmonic Content �0.000001% [–160 dB].

SMPTE/DIN Waveform

Upper Tone Range 2 kHz to 47% of Sample Rate
[22.56 kHz at 48 ks/s].

Lower Tone Range 40 Hz–500 Hz.

Amplitude Ratio 1:1 or 4:1 (LF:HF).

Distortion/Spurious �0.000001% [–160 dB] at 4:1 ratio.
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Figure 60. Shaped Sine Burst signal.

(1 kHz, 10 cycles)



CCIF and DFD IMD Waveforms

Center Frequency Range 3.00 kHz to (47% of Sample Rate –½ IM freq.).

IM Frequency Range 80 Hz–2.00 kHz.

Distortion/Spurious �0.000001% [–160 dB].

DIM IMD Waveform

Square/Sine Frequencies Determined by Sample Rate (see Note below).

Distortion/Spurious �0.000001% [–160 dB].

The DIM test signal consists of a square wave and a sine wave

mixed in a 4:1 amplitude ratio. Since digital square waves are

generated by alternately turning the output on and off for the

same number of sample periods, the frequencies achievable

are limited to even sub-multiples of the Sample Rate. Because

of this constraint, the square wave frequency is chosen first to

be as close to the “ideal” analog test frequency as possible.

The sine wave frequency is then chosen based upon the ideal

sine/square frequency ratio. The following table lists some

examples for the DIM and DIMB signals:

Noise

Types Pink, White, Burst, USASI.

Special Signals

Monotonicity Low level staircase waveform for D/A linearity
testing.

J-Test Produces a maximum amount of data-induced
jitter on low-bandwidth transmission links.

Polarity Two sinewaves phased for reinforcement with
normal polarity.

Walking Ones A single binary one value “walked” from LSB to
MSB.

Walking Zeros A single binary zero value “walked” from LSB to
MSB.

Constant Value

(Digital dc) 32-bit resolution when using triangular dither.
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DIM: “ideal” square frequency = 3150, sine/square frequency ratio = 100/21

Sample Rate Square Wave Frequency Sine Wave Frequency

44100 3150 15000

48000 3000 14285.7

DIMB: “ideal” square frequency = 2960, sine/square frequency ratio = 175/37

44100 3150 14898.65

48000 3000 14189.19



Random (Bittest) Pseudo-random binary states of all bits.

Pass Thru Passes the signal from the rear panel Ref Input.
Accepts sample rates from 27 kHz–200 kHz and
outputs at programmed sample rate. Ratio of
rates may not exceed 7.75:1.

Quasi-Anechoic Acoustical Tester (MLS)

(Also see MLS in Digital Analyzer section, page 82)

Signals Four pink sequences, four white sequences.

Frequency Range dc to Sample Rate � 2.

Sequence Length 32767 samples or 131071 samples.

Arbitrary and Multitone Waveforms (“Arb Wfm”)

Stored waveform consisting of multiple sine waves, each at independent frequency,
amplitude, and phase

Signal Determined by the associated file specified in the
panel drop-down box.

Frequency Range dc to Sample Rate � 2.

Length 256 points–16384 points per channel. Utility is
provided to prepare waveform from user specified
frequency, amplitude, and phase data.

Frequency Resolution Sample Rate � Length
[2.93 Hz at 48 ks/s for a waveform 16384 points
in length].

Maximum Number of Tones (Length / 2) –1 [8191 for Length = 16384].

Dither

(May be enabled for all waveforms except Monotonicity, J-Test, Walking Ones and Zeroes,
and Random)

Probability Distribution Triangular or rectangular; pseudo random,
independent for each channel.

Spectral Distribution Flat (white) or Shaped (+6 dB/oct).

Amplitude 8 bit–24 bit, or OFF.

Pre-Emphasis Filters

(all waveforms)

Filter Shape 50/15 µs or J17.

Response Accuracy �0.02 dB, 10 Hz to 45% of Sample Rate.

Residual Distortion �0.00003% [–130 dB].
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Digital Analyzer

Available only in the SYS-2720 and SYS-2722 configurations.

Digital Interface Signal Measurements

Input Sample Rate

Range 28 kHz–200 kHz for fully specified performance,
typically <24 kHz–216 kHz.

Accuracy

Int. Reference ��0.0003% + 1 digit) [�3 PPM].

Ext. Reference �(0.0001% + 1 digit) [�1 PPM].

Input Amplitude

Balanced (XLR) 0 Vpp–10.00 Vpp, �(5% + 25 mV).

Unbalanced (BNC) 0 Vpp–2.5 Vpp, �(5% + 6 mV).

Optical Displays voltage of internal logic signal (not
linearly related to optical input power).

Jitter Measurement

Range
24

0 UI–0.200 UI [0 ns–32 ns at 48k, 0 ns–8.0 ns at
192k, etc.].

Accuracy �(10% + 1.0 ns), peak calibrated.

Detection “Pk” (for measurements per AES-3), or
“Avg” (for transfer function measurements).

Bandwidth <50 Hz–100 kHz,
120 Hz–100 kHz,
700 Hz–100 kHz, or
1.2 kHz–100 kHz.

Flatness
25

�1 dB, 100 Hz–50 kHz.

Residual Jitter
26

�600 ps with “700 Hz–100 kHz” bandwidth,
�1.0 ns with “50 Hz–100 kHz” bandwidth.

Jitter Spectrum Spurious products are typically 40 dB below jitter
signal or <0.0003 UI [–70 dBUI], whichever is
larger.

Common Mode Amplitude 0 Vpp–20.0 Vpp, �(10% + 50 mV),
100 Hz–100 kHz.

Channel Status Bits Full implementation, English language decoded
(Professional or Consumer) hex formats,
independent in each channel.

User Bits Not displayed.

Validity Flag Displayed for each channel.

Parity Displayed for total signal (both channels
combined).

Output to Input Delay Measures propagation from the rear panel AES/
EBU Reference Output to the input.

Range –12.7 to +115.1 UI [–10% to +90% of frame] in
seconds, 60 ns resolution.
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24
The maximum measureable jitter increases to 1.000 UI for sine wave jitter signals below 1 kHz decreasing to
0.200 UI at or above 8 kHz.

25
System specification at 32, 44.1, 48, 88.2, 96, 176.4, and 192 ks/s using the “50 Hz to 100 kHz” analyzer
bandwidth selection. Flatness of the jitter generator will exhibit degradation at other sample rates.

26
Applies to balanced and unbalanced signal formats only. Specification subject to the following conditions: (1)
all jitter generator impairments must be turned off or disabled including the delay from reference output feature,
(2) the digital input signal must be � 1.5 Vpp (AES/EBU) or � 300 mVpp (SPDIF-EIAJ) and have a risetime
� 20 ns. Jitter via the optical path may be considerably worse with embedded audio or dither enabled.



Signal Confidence Displayed for total signal (both channels
combined)

Receiver Lock Displayed for total signal (both channels
combined).

Coding Error Displayed for total signal (both channels
combined).

Digital Interface Analyzer

with “INTERVU” DSP program

The Digital Interface Analyzer (Intervu) operates in conjunction with an 8-bit A/D

converter clocked at 80.0 MHz. The analyzer can display the interface signal in time or

frequency domain, as an eye pattern, or probability graphs of amplitude or pulse width.

The Digital Interface Analyzer can also demodulate the jitter signal and display it in

time or frequency domain or as a histogram. The jitter signal or the data on the

interface may be reproduced through the monitor loudspeaker.

AES/EBU Input Voltage

Balanced 0 Vpp–10.00 Vpp,
�(10% + 50 mV).

Unbalanced 0 Vpp–2.5 Vpp,
�(8% + 12 mV).

Jitter Amplitude 0 UI–5 UI pk,
�(5% + 0.015 UI).

Residual Jitter �0.01 UI (50 Hz–1 MHz BW).

Spurious Jitter Products �0.001 UI, or �–60 dB below jitter signal.

Common Mode Amplitude 0 Vpp–20.00 Vpp, �(30% + 50 mV),
20 kHz–1 MHz.

Jitter Probability Display 256 bins, auto-ranging.

Input Probability Display 256 bins, auto-ranging.

Bit Width Probability Display 32768 bins.

Risetime Typically 17 ns–20 ns.

Acquisition time / memory 19.66 ms / 1,572,864 samples.

Embedded Audio Measurements

With “ANALYZER” DSP program

Wideband Level/Amplitude

Range –120 dBFS to 0 dBFS (usable to –140 dBFS).

Frequency Range 10 Hz to 45.8% of Sample Rate,
[10 Hz–20.2 kHz at 44.1 ks/s],
[10 Hz–22.0 kHz at 48 ks/s],
[10 Hz–44.0 kHz at 96 ks/s].

Accuracy �0.01 dB.

Flatness �0.01 dB, 15 Hz–22 kHz
(<10 Hz high-pass filter selection).

Digital Analyzer Chapter 6: Specifications

Getting Started with Your 2700 Series Instrument 79



High pass Filters <10 Hz (4-pole),
22 Hz (4-pole),
100 Hz (4-pole),
400 Hz (4-pole Butterworth, or 10-pole elliptic if
no other filters are enabled).

Low pass Filters fS/2 (maximum bandwidth),
20 kHz (6-pole elliptic),
15 kHz (6-pole elliptic).

Weighting Filters ANSI-IEC “A” weighting, per IEC Rec 179,
CCIR QPk per CCIR Rec. 468,
CCIR RMS per AES17,
C-message per IEEE Std 743-1978,
CCITT per CCITT Rec. O.41,
“F” weighting corresponding to 15 phon loudness
contour, –see Figure 58, page 70
HI-2 Harmonic weighting.

Residual Noise –141 dBFS unweighted,
(at 48 ks/s and 96 ks/s fs) –144 dBFS A-weighted,

–140 dBFS CCIR RMS,
–130 dBFS CCIR QPk,
–142 dBFS 20 kHz LP,
–143 dBFS 15 kHz LP,
–139 dBFS “F” weighting,
–152 dBFS CCITT,
–151 dBFS C Message.

Narrow Band Amplitude

Frequency Range 10 Hz to 40% of Sample Rate,
[10 Hz–17.6 kHz at 44.1 ks/s],
[10 Hz–19.2 kHz at 48 ks/s],
[10 Hz–38.4 kHz at 96 ks/s].

Filter Shape 10-pole, Q=19 (BW = 5.3% of fo).
–see Figure 59, page 70

Residual Distortion �–150 dBFS.

THD+N Measurements

Frequency Range <10 Hz to 47% of Sample Rate,
[10 Hz–19.9 kHz at 44.1 ks/s],
[10 Hz–21.6 kHz at 48 ks/s],
[10 Hz–43.2 kHz at 96 ks/s].

Residual THD+N �–138 dBFS. –see Figure 61, page 83

High pass Filters <10 Hz (4-pole),
22 Hz (4-pole),
100 Hz (4-pole),
400 Hz (4-pole Butterworth).

Low pass Filters FS/2 (maximum bandwidth),
20 kHz (6-pole elliptic),
15 kHz (6-pole elliptic).

Weighting Filters Same as Wideband Level/Amplitude.

Residual Noise Same as Wideband Level/Amplitude.

Frequency Measurements

Range 10 Hz to 47% of Sample Rate,
[10 Hz–21.0 kHz at 44.1 ks/s],
[10 Hz–23.0 kHz at 48 ks/s],
[10 Hz–46.0 kHz at 96 ks/s].
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Accuracy �0.01% of reading or 0.0001% of Sample Rate,
whichever is greater.

Resolution 0.003% of reading or 0.0001% of Sample Rate,
whichever is greater.

Phase Measurements

Measurement Ranges �180, –90/+270, or 0/+360 degrees.

Accuracy
27

�0.05 degree, 10 Hz to 45% of Sample Rate.

Resolution 0.01 degree.

Minimum Input –30 dBFS, both inputs.

SMPTE IMD Measurements

Test Signal Compatibility Any combination of 40 Hz–250 Hz (LF) and
(2 kHz to 45% of Sample Rate) (HF) tones, mixed
in any ratio from 1:1 to 5:1 (LF:HF).

IMD Measured Amplitude modulation products of the HF tone.
(–3 dB measurement bandwidth is
10 Hz–750 Hz.)

Measurement Range 0%–20%.

Accuracy �0.5 dB.

Residual IMD �–130 dB at 0 dBFS, 60 + 7 kHz or 250 + 8 kHz
�–110 dB at –25 dBFS, 60 + 7 kHz or 250 +
8 kHz.

Embedded Audio, FFT Spectrum Analyzer

with “FFT” DSP program (48-bit processing)

Acquisition Length 800 samples–4 M samples in 15 steps.

Transform Length 256–32768 samples in binary steps.

Windows Blackman-Harris (4-term with –92 dB sidelobes),
(see Figures 56 and 57, Hann,
page 69) Flat-top,

Equiripple (AP design –160 dB sidelobes),
None,
None, move to bin center,
Hamming,
Gaussian,
Rife-Vincent 4-term,
Rife-Vincent 5-term.

Amplitude Accuracy �0.001 dB, 20 Hz–20 kHz,
with Flat-top window.

Phase Accuracy
28

�0.05 degree, 10 Hz to 45% of Sample Rate.

Resolution 0.01 degree.

Averaging 1–4096 averages in binary steps. Averaging is
power-based (frequency domain), or
synchronous (time domain).
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Both DSP analyzer input channels must have the same coupling (ac or dc) selection. Accuracy is valid for any
input signal amplitude ratio up to ±30 dB.

28
Both DSP analyzer input channels must have same coupling (ac or dc) selection. Accuracy is valid for any

input signal amplitude ratio up to ±30 dB



Distortion Products �–160 dB.

Display Modes

Time Domain Normal, Interpolate, Peak or Max.

Frequency Domain Peak pick, individual bin, Smoothing.

Move to bin center Window

Frequency Range 7
th

bin to 45% of Sample Rate, and �4% of input
frequency[21.6 kHz at 48 ks/s].

Amplitude Accuracy �0.025 dB.

Spurious Products �–120 dB.

Embedded Audio, Multitone Audio Analyzer

with “FASTTEST” DSP program (48 bit processing)

Acquisition Length 512–32768 samples in binary steps.

Transform Length 512–32768 samples in binary steps.

Measurements Level vs frequency,
Total distortion vs frequency,
Noise vs frequency,
Phase vs frequency,
Crosstalk vs frequency,
Masking curve.

Frequency Resolution Sample Rate ÷ 2
15

[1.465 Hz with 48 ks/s].

Frequency Correction Range �3%.

Distortion �–140 dB.

Embedded Audio, Quasi-Anechoic Acoustical Tester

with “MLS” DSP program

Signals Four pink sequences and four white sequences,
selected by triggering generator MLS setting.

Frequency Range (Sample Rate � 2000) to (Sample Rate � 2).

Frequency Resolution (Max) 1.465 Hz at 48 ks/s.

Acquisition Length 32767 or 131071 samples, selected by triggering
generator MLS setting.

FFT Length 32768.

Energy Time Windows half Hann,
Hann,
<240 Hz >8 kHz,
<120 Hz >16 kHz.

Time Windows <5%,
(percent of data record to <10%,
transition from 0 to full <20%,
amplitude) <30%.

Averaging 1–4096 averages in binary steps, synchronous.
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Graphs of Typical Digital Domain Performance
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Figure 61. Typical Digital Domain system residual THD+N showing

components below –140 dB.

Figure 62. Illustration of typical Digital Domain FFT dynamic range.

Signal is 0 dB 1 kHz with a secondary signal at –120 dB and

2.5 kHz.



Front Panel Auxiliary Signals

Generator Monitors

(all units except SYS-2720.)

Channel A Buffered version of the channel A analog
generator signal. Amplitude is typically 2.8 Vpp.

Channel B Buffered version of the channel B analog
generator signal. Amplitude is typically 2.8 Vpp.

Generator Auxiliary Signals

(all units except SYS-2720.)

Sync Output LSTTL compatible signal that is intended to be
used as a trigger for stable oscilloscope displays.

Trig/Gate Input LSTTL compatible input, functional with option
“BUR” only.

Analyzer Signal Monitors

(all units except SYS-2720.)

Channel A Buffered version of the channel A analog input
signal. Amplitude is typically 0 Vpp–3.6 Vpp.

Channel B Buffered version of the channel B analog input
signal. Amplitude is typically 0 Vpp–3.6 Vpp.

Reading Buffered version of the analog analyzer output
signal after all filtering and gain stages. Amplitude
is typically 0 Vpp–3.6 Vpp.

Digital Signal Monitors

(SYS-2720 & SYS-2722 only.)

Via four 24-bit D/A converters. Function monitored depends upon analyzer

program loaded; for example, noise and distortion products after the notch fil-

ter are monitored with “DSP Audio Analyzer” in its THD+N function.

Channel 1 Buffered version of the digital channel 1 signal.

Channel 2 Buffered version of the digital channel 2 signal.

Reading 1 Distortion of the digital channel 1 signal.

Reading 2 Distortion of the digital channel 2 signal.
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Rear Panel Auxiliary Signals

Reference Input (“REF IN”) Characteristics

The reference input provides the ability to synchronize the internal sample rate

generator to an external signal. The sample rate need not be at 1:1 ratio to the reference,

but will be locked to the reference over the fully specified range of sample rate and

Reference inputs. PLL bandwidth is approximately 5 Hz.

Input formats 28 kHz–200 kHz AES/EBU,
NTSC, PAL, or SECAM video, or
8 kHz–10 MHz square wave.

Sample Rate Resolution

8 kHz–65 kHz 1/128 Hz [0.0078125 Hz].

65 kHz–256 kHz 1/32 Hz [0.03125 Hz].

256 kHz–1 MHz 1/8 Hz [0.125 Hz].

1 MHz–4 MHz ½ Hz [0.5 Hz].

4 MHz–10 MHz 2 Hz.

Input Amplitude 200 mVpp–5.0 Vpp.

Input Impedance Selectable terminated or high impedance.

AES/EBU (XLR) Nominally 110� or 5k�.

Video/TTL (BNC) Nominally 75� or 5k�.

Lock Range �0.0015% [�15 PPM].

Input Delay from –12.7 to +115.1 UI [–10 to +90% of frame] in
Reference Display seconds, �60 ns, AES/EBU signals only.

Reference Rate Display Measures approximate reference input rate.

Reference Output (“REF OUT”) Characteristics

Intended to drive devices under test that require their own reference input. The

reference output signal is not jittered.

Output format AES/EBU (per AES3-r1997).

Output Sample Rates 8 kHz–216 kHz, locked to front panel output.

Status Bits Format “Professional,”
Type “Grade 2 reference,”
Origin “SYS2,”
Reliability flags implemented,
CRCC implemented,
Time of Day not implemented,
Sample Count not implemented.
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Figure 64.

Miscellaneous

digital I/O panel

(rear of SYS-2720

and SYS-2722

instruments only).



Output Delay from –64 to +63.5 UI in 0.5 UI steps,
Reference Output �(5% + 0.5 UI).

Residual Jitter �600 ps (700 Hz–100 kHz BW).

Miscellaneous Digital I/O

Transmit Frame Sync Square wave at the programmed internal sample
rate (SR).

Receive Frame Sync Square wave at the frame rate of the received
AES/EBU signal.

Master Clock Out Square wave at a multiple of the System Sample
Rate (“SSR”). The multiple is:
1024x for SSR = 8 kHz to <13.5 kHz,
512x for SSR = 13.5 kHz to <27 kHz,
256x for SSR = 27 kHz–108 kHz.
Selectable between jittered and un-jittered
signals.

Auxiliary Input LSTTL compatible trigger input for DSP program
data acquisition.

Auxiliary Output HCMOS signal, function under DSP program
control.

Trigger Output HCMOS signal, coincident with period of
generated signal waveform.

Parallel Input and Output For use with optional PSIA-2722 accessory.
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Audio Monitor

All configurations contain an internal loudspeaker and headphone jack for listening

to the generator, analyzer, or digital signal monitor points, including noise and

distortion following analog or digital notch filters or the AES/EBU jitter signal. Use of

the audio monitor does not preclude the use of any measurements.

Power Output Typically 1 Watt.

General/Environmental
Power Requirements 100/120/230/240 Vac (–10%/+6%),

50/60 Hz, 240 VA max.

Temperature Range

Operating +5°C to +40°C.

Storage –40°C to +75°C.

Humidity 90% RH (non-condensing).

Altitude 2000 m.

EMC
29

Complies with 89/336/EEC, CISPR 22 (class B),
and FCC 15 subpart J (class B).

Dimensions

Width 41.9 cm [16.5 inches].

Height 14.6 cm [5.75 inches] bench-top (feet attached)
3U [5.25 inches] rack-mount.

Depth 34.5 cm [13.6 inches].

Weight Approximately 15.4 kg [34 lbs].

Safety Complies with 73/23/EEC, 93/68/EEC, and
EN61010-1 (1990) + Amendment 1 (1992) +
Amendment 2 (1995).
Installation Category II, Pollution Degree 2.
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29
Emission and immunity levels are influenced by the shielding performance of the connecting cables. The
shielding performance will depend on the internal design of the cable, connector quality, and the assembly
methods used. EMC compliance was demonstrated using Audio Precision pn 4155.0117 cables for all ports
using XLR-type connectors, Audio Precision pn 4155.0301 cable for the Master Clk port, and Pasternack
Model No. PE3067-36 for all remaining ports using BNC-type connectors.



Cables and Adapters

Analog Audio Cables

These cables provide a convenient method to connect Audio Precision mea-

surement equipment with a device under test. The cable kits consist of four ca-

bles, each with a unique color band at the connector ends to facilitate

identification. The cables are high quality Mogami NEGLEX super flexible

shielded cable, and are 8 ft (2.4 m) long. The cables and connector shells are

satin black, and all connectors have gold plated contacts.

� CAB-XMF consists of a set of four XLR male to XLR female cables.

� CAB-XBR consists of a set of four cables: two with RCA/PHONO male

to XLR male connectors, and two with RCA/PHONO male to XLR fe-

male connectors. Also provided are four adapters, from RCA female to

BNC male. The cables are wired with pin 2 of the XLR connector as

“hot” (center pin of the RCA connector) and pins 1 and 3 connected to

ground and shield, to agree with the unbalanced wiring convention of

Audio Precision instruments. See Figures 65 and 66.
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Figure 65. CAB-XBR cable kit



Digital Audio Cables

These cables are designed for digital audio connections using the AES/EBU

format, XLR connectors, 110 � cable, double-shielded for improved EMI per-

formance.

� CAB-AES: Set of two AES/EBU cables, 39 in (1 m) long. See Figure 67.

� CAB-AES2: Set of two AES/EBU cables, 6.5 ft (2 m) long.

� CAB-AES4: Set of two AES/EBU cables, 13 ft (4 m) long.

� CAB-DIO: Set of two interface cables, 4.25 ft (1.3 m) long, to connect

between the SYS-2722 rear panel 50-pin ribbon input/output connectors

to a DUT fixture with 0.1 in spaced 2 x 25-pin headers. See Figure 68.
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Figure 66. XLR to BNC wiring

Figure 67. CAB-AES cable set



Cable Adapters

� CAD-RCA: set of 14 RCA/Phono female to BNC male adapters, in-

tended primarily for use with the SWR-2122U Unbalanced Switcher.

Digital Control (APIB) Cables

These cables can be used as extensions or replacements for the APIB cables

that come with each switcher or DCX-127.

� CAB-D0: Extension APIB Interface cable, 20 in (0.5 m).

� CAB-D2: Extension APIB Interface cable, 6.5 ft (2 m).

� CAB-D6: Extension APIB Interface cable, 12.7 ft (6 m).
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Figure 68. CAB-DIO cables.
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